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Level 1 - Beginner Training

STK Level 1 - Beginner training is designed to familiarize first-time users with STK workflow and provide a basic
understanding of STK software capabilities. This training is designed to allow you to model and incorporate your
own systems and missions throughout the lessons.

Free License

This training covers the basics of STK that can be completed with the free license. You can download STK and
obtain a free permanent license by visiting our website (https://licensing.agi.com/stk/demo).

The Level 1 - Beginner training is a series of tutorials designed to get the user started using STK.

Tutorial Description License Required
Create a Scenario Learn how to create a scenario in STK STK (Free)
Insert STK Objects Learn how to add STK objects to a scenario. STK (Free)
Modify STK Objects Learn how to modify STK objects in a scenario. STK (Free)
Compute Access Learn how to compute access between objects. STK (Free)
Create Reports & Graphs Learn how to generate reports and graphs in STK. STK (Free)
Send Connect Commands Learn how to send Connect Commands in STK. STK (Free)
Make a Movie Learn how to make a movie in STK. STK (Free)

Once you have completed these tutorials, you will be ready to take the free level 1 STK Certification test! Visit
www.agi.com/training/

E‘ Note: For the STK 10 version of this training, visit
http://help.agi.com/StartTraining/StartTraining1013.htm
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Part 1: Model Comelex sttems

Lesson 1.1: STK Scenarios

When STK launches, the Welcome dialog will appear. Using the options available here, you can create new
scenarios, open existing scenarios, access the STK Help System, or exit the STK application.

g/i‘ Note: This training focuses on the latest capabilities available with STK. You can learn more about
STK and download the software on our website (https://licensing.agi.com/stk/demo).
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Task: Create a New Scenario

1. Create a new scenario.

a. Launch STK (@).

b. Create a Scenario (ﬁ).
¢. Inthe New Scenario Wizard set the following options:
a. Name the scenario ("STK_Fundamentals").
b. Define the analysis start and stop times or accept the defaults.
c. Click OK.
2. Customize the STK Workspace.

a. Close the Insert STK Objects Tool. We will explore this later.

b. Close the Timeline View by clicking the (il) in the upper-right corner of the
Timeline View.

¢. Maximize () the 3D Graphics window.

B‘ Note: STK organizes the integrated windows with
tabs at the bottom of the integrated workspace.

d. Extend the Window menu and select Tile Vertically to center the windows
in the workspace.
3. Save the scenario.
a. Extend the File menu and select Save (@) to save the scenario.

a. STK automatically creates a directory with the same name as
your scenario.

4. Explore the 2D Graphics window:

a. Use the mouse controls to zoom and pan around the 2D Graphics
windows.

a. To pan, hold the left mouse button and drag the mouse around
the 2D Graphics window.

b. To zoom in and out, use the mouse scroll wheel or the zoom

icons (@», @»).
5. Explore the 3D Graphics window:

i. To rotate the globe, hold down the left mouse button and move the
mouse around.

ii. To zoom, hold the right mouse button and move the mouse up and
down (or use the mouse scroll wheel).
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iii. Tozoominonan area, clickthe Zoom In (@s) button and drag a box
around the area of interest.

iv. To pan around, enable the Grab Globe (éﬂ?) mode and hold the
Shift key and left mouse down and move the mouse around.

v. Use the Home View (‘E}) button to return to the default Earth view.

ROTATE VIEW z00M ZOOM IN ON REGION PAI RESET VIEW

@-'-4{» @er@{': Q+@+«‘» +@+N@+«t»

Mouse controls for 3D.

6. Animate through the scenario

a. Use the Animation Controls to play through the scenario.
a. Play(’ ) or Step Forward (l’) or Step Backward (‘l).
b. Pause (ll) the action.
C. Increase (ﬂ) or Decrease (E) the speed of the animation.

d. Reset (l‘) the action.

b. If the Timeline View is closed, extend the View menu and select Timeline
View to reopen the Timeline View.

C. Use the slider bar in the Timeline View to scroll through the scenario time
period.

If you get lost in the 3D Graphics window, click the Home View (g’) button. The Home View re-
orients the 3D Graphics camera back on the default Earth View.

If you get lost in the animation period, click the Reset (l‘) button. The Reset button stops the
animation and resets it to the animation start time.

We have provided a quick reference guide for the basic toolbars in STK. You can find it here
(PDF).
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Part 2: Insert STK Ob'!ects

Lesson 2.1: Insert STK Objects

STK Objects provide a generic template for modeling land (ﬁ), sea (i), air (ﬂ), and space vehicles (ﬁ), sites

on the ground ( , ), sensors (&I ). The Insert STK Objects tool (ﬁﬁ) allows you to select any STK Object on
the left and one of the corresponding insert methods on the right.
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Task: Insert and Configure Objects

1. Model at least one ground site (any type: Qﬁ@)

a. From the Insert STK Objects tool (ﬁg), select Place (Q ) and choose one of
the available methods (examples below).

a. From City Database

Vi.

Vil.

vii.

In the Insert STK Objects tool (ﬁﬁ) select Place (I:FI ).

ii. Select From City Database from the Select A Method list.

iii. Click Insert... to bring up the City Database.

In the City Name text field, enter a city name (e.g.
Bloomington).

Click Search. The matching cities will be shown in the results
list.

Select the result corresponding to the desired Province (e.g.
Minnesota) from the list.

Click Insert.

Click Close to close the City Database window.

-

=

b. Search by Address (requires Internet ( @ ))

Vi.

Vii.

viii.

iX.

In the Insert STK Objects tool (ﬁﬁ), select Place (I:;I ).

ii. Select Search by Address from the Select A Method list.

iii. Click Insert... to bring up the Insert by Address search tool.

In the search text field, enter an address (e.g. 1600
Pennsylvania Ave, Washington DC).

Click Search. The matching addresses will be shown in the
results list.

Select a corresponding Result (e.g. 1600 Pennsylvania Ave,
Washington DC) from the list.

Select the desired Color in the lower-left (e.g. White).
Click Insert.

Click Close to close the Insert by Address window.

b. From the Insert STK Objects tool (ﬁﬁ), select Facility (ﬁ) and choose one
of the available methods (examples below).
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a. Insert Default

i. Inthe Insert STK Objects tool (ﬁﬁ), select Facility (ﬁ).
ii. Select Insert Default as the Select A Method option.
iii. ClickInsert....
iv. Right-click the facility (ﬁ) in the Object Browser, and select
Rename (e.g. AGI_HQ).

b. From Standard Object Database

[~
i. Inthe Insert STK Objects tool (ﬂﬁ), select Facility (ﬁ).

ii. Select From Standard Object Database as the Select A
Method option.

iii. Click Insert... to bring up the Facility Database.
iv. Inthe Name text field, enter a Site Name (e.g. Guam 2).

V. Click Search. The matching facilities are displayed in the
Results list.

E‘ Note: You may see duplicate results. Scroll to

— the right to see the Source. If an internet
connection exists, results will display from both
AGl's Standard Object Database (requires
internet) and the Local Database. If no internet
connection exists, STK will only search the local

database.
L J

vi. Select the corresponding result (e.g. Guam 2 GU2 Leolut)
from the list.

vii. Click Insert.

viii. Click Close to close the Facility Database window.

From the Insert STK Objects tool (?Eg), select Target (@) and choose one
of the available methods (example below).

a. Insert Default

]
i. Inthe Insert STK Objects tool (ﬁg), select Target (@).
ii. Select Insert Default as the Select A Method option.

iii. Click Insert...
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—¢" Note: The default target object s located at zero
(0) degrees latitude and zero (0) degrees
longitude.

2. Center your 3D view on a ground site (Q ’ ﬁ @).

a. Inthe STK Object Browser, right-click on a ground site (.;} ’ ﬁ 9) and
select Zoom To.

b. Use the Home View (@) button to reset the 3D view.
3. Model at least one moving vehicle (any type: % % {).

a. From the Insert STK Objects tool (ﬁg), select Satellite (%) and choose one
of the available methods (examples below).

a. Search From Standard Object Database

i. Inthe Insert STK Objects tool (ﬁﬁ) select Satellite (ﬁ
).

ii. Selectthe From Standard Object Database as the
Select A Method option.

iii. ClickInsert... to bring the Standard Object Database
to the front.

iv. Inthe Name or ID text field, enter a Satellite Name or
ID (e.g. Geoeye).

V. Click Search. The matching satellite are shown in the
Results field.

r )

E‘ Note: You may see duplicate results.

— Scroll to the right to see the Source. If an
internet connection exists, results will
display from both AGI's Standard Object
Database (requires internet) and the Local
Database. If is no internet connection
exists, STK will only search the local
database.

Click on the Advanced... button for more
Insert options. Here you can choose the
analysis time period, the propagation

step size and TLE source.

\ J

vi. Select the corresponding result (e.g. Official
Name=GeoEye 1) from the list.
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vii. Click Insert.

viii. Click Close to close the Satellite Database window.

b. Design an Orbit with the Orbit Wizard.

&

Vi.

Vii.

In the Insert STK Objects tool (ﬁﬁ), select Satellite (ﬁ).

ii. Select Orbit Wizard as the Select A Method option.

iii. Click Insert... to bring the Orbit Wizard to the front.

Select an orbit Type (e.g. Circular).
Set the Satellite Name (e.g. CircularSat).

Enter the desired parameters in the Definition area (e.g.
RAAN 160 deg).

Click OK to insert the satellite into the scenario and close the
Orbit Wizard window.

Insert a satellite from an Archived Database.

Obtain an Archived Satellite Database.

i. Open the Scenario's (ﬁ) properties (El).
ii. Select the Basic - Database page.
iii. Click the Update Database Files... button.
iv. Select the Obtain Archived Database option.

V. Specify the Archive Date by entering it in the text field
or using the drop-down menu.

vi. Click the Update button. If an archive is not available
for the specified date, the archive for the next newest
data is used instead.

Insert a Satellite from an Archived Satellite Database.
i. From the Insert STK Objects (ﬁé) menu, select the

Satellite (%) object on the left.
ii. Selectthe From TLE File method.

iii. Click the Insert... button.

iv. Navigate to the archived satellite database file (e.g.
C:\ProgramData\AGN\STK 11
(x64)\Databases\Satellite) and select the updated file
(e.g. stkAIITLE.tce).

V. Click Open.
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vi. Click the Modify... button.

vii. Disable the On propagation, automatically retrieve
elements option.

viii. Click OK.

ix. Use the Common Name and SSC Number fields to
search through the archived database.

X. Select the desired satellite in the results list and click
Insert.

xi. Click Close to close the Insert From Satellite Database
Window.

b. Model an Aircraft (ﬂ) using one of the options below.

a. Typing in Waypoints

Vi.

In the Insert STK Objects tool (ﬁﬁ) select Aircraft (ﬂ).

ii. Select Define Properties as the Select A Method option.

iii. Click Insert... to bring the Properties Browser to the front.

Click Insert Point twice to add two waypoints manually.

Enter values for the second waypoint (e.g. Lat = 10 deg, Lon
= 10 deg).

Click OK to dismiss the Properties Browser.

b. Clicking the Waypoints in the 2D Graphics window.

. Clicking the Waypoints in the 3D Graphics window.

Vi.

In the Insert STK Objects tool (%ﬁ) select Aircraft (ﬂ).

ii. Select Insert Default as the Select A Method option.

iii. ClickInsert....

Bring the 3D Graphics window to the front.

Select the new aircraft in the 3D Object Editing toolbar (
€k Aircraft/Aircraft3 M —

— )

Click the Object Edit Start ( ﬂ) button to start the object
editor.
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vii. Add, modify, or remove waypoints directly in the 3D Graphics
window:

ADD: [ sirr +%

MODIFY: ‘-jl\l} + % + Q*’
¥
REMOVE: | sHIFT +"'“-;%+ @

viii. If you want to start over, click the Cancel (@E) button, then
start editing again.

ix. When you finish, click the Object Edit Accept () button.

¢. Model a Missile (J) using one of the options below.

a. Typing in the Launch and Impact locations.

b. Clicking the Launch and Impact Locations in the 2D Graphics
window.

i. Zoom In and Pan the 2D Graphics window so the desired
launch and impact points are in view.
» You cannot Panin the 2D Graphics window while the
Properties Browser is open. Every click is considered a
launch or impact point.

ii. Inthe Insert STK Objects tool (%ﬁ) select Missile ({).

ii. Select Define Properties as the Select A Method option.
iv. Click Insert... to bring the Properties Browser to the front.
V. Clickinthe 2D map to edit the launch location.

vi. Click OK to dismiss the warning box that explains the delta V
changed.

vii. Click in the 2D map to edit the impact location.
viii. Click OK to dismiss the Properties Browser.

4. Center your 3D view on an STK Vehicle.

a. Inthe STK Object Browser, right-click on a vehicle (ﬁ, % f) and select
Zoom To.

b. Click Reset (l‘) to reset the animation time.
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N
¢. To slow down the animation, click the Decrease Time Step (‘Uﬁ) button.

E‘ Note: The current time step is in the lower-right corner of the
STK GUL.

d. Click Play ( b ) to watch the vehicle move along its path.

e. Use the Home View (‘E’) button to reset the 3D view to center the Earth.

5. Add aninterval to your Timeline View for an STK vehicle (ﬁ, %g ﬁ’).

a. Ifyour Timeline View is not open, extend the STK View menu and select
Timeline View.

b. Inthe Timeline View toolbar, select Add Time Components (@).

C. Select the STK vehicle object on the left (e.g. Aircraft1).

d. Selectany time interval on the right (e.g. EphemerisTimeSpan) and click OK.
e. Right-click on the new interval in the Timeline View and select Center.

f. Use the gray slider bar (=) to scroll through the time intervals.

g. Right-click on the Scenario availability interval (top row) and select Center.

h. Close the Timeline View to de-clutter screen.

6. Model a Sensor (@) on at least one ground site and each moving object.
a. Inserta Sensor (@) ona ground site (any type: I"‘r_-':l : ﬁ @).

i. Inthe Insert STK Objects tool (ﬁﬁ), select Sensor (@).
ii. Select Insert Default as the Select A Method option.

iii. Click Insert... to bring the Select Object window to the front.

iv. Selecta ground site (any type: ';.-:' ’ ﬁ 9) in the Select Object
window (e.g. Bloomington).

V. Click OK.
b. Inserta Sensor (@) on a vehicle (any type: % % ﬁ).

i. Inthe Insert STK Objects tool (%5), select Sensor (@).
ii. Select Insert Default as the Select A Method option.

iii. Click Insert... to bring the Properties Browser to the front.
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iv. Selecta vehicle (any type: ﬁ 'ﬂ ¥) in the Select Object window
(e.g. CircularSat).

v. Click OK.
. . . . \
0 Did You Know? You can importa KML file and use it as an STK Object. Open the Globe Manager (
ﬁ) and select the KML tab. You can import your own KML here or browse to <STK install
folder>\Data\Resources\stktraining\imageryKML\MtStHelens.kmz.
J
)
AGI Techs Say: When you insert a satellite from the Standard Object Database, the database uses
the most current TLE data available. If you're working in an offline environment, you can download
all current and archived satellite databases on AGl's website at
http://www.agi.com/resources/satdb/satdbpc.aspx.
J
)
0 Warning: Don't forget to save your work!
J
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Part 3: Ob'!ect Proeerties

Lesson 3.1: Object Properties

Customizing properties creates a meaningful environment for the objects in the scenario. The properties used to
e

define STK objects and visualization windows are organized in the Properties Browser (=I). Each type of STK
object has its own set of properties, which are organized into four main categories.

Q Case Study
Lockheed Martin Aeronautics is using STK to provide a Test and Evaluation (T&E)
integrated solution for the F-35 Lightning Il Program, utilizing the STKExternal
Propagator. You can find out more about the F-35 Lightning Il Program on our
website.

—_

Basic properties define the foundation for the type of object selected.

2. 2D Graphics modify the general elements of an object's display in the visualization windows, such as color,
line style, and markers.

3. 3D Graphics modify the three-dimensional elements of an object's display, such as the 3D model - AGI
(*.mdl) or COLLADA models, dynamic data displays, etc.

4. Constraints define conditions that must be met before links become available (geometry, visibility, lighting,

timing, RF signal strength).

Did You Know? STK allows a user to import data to define a vehicle route, orbit, or trajectory. You
can accomplish this through the use of an external ephemeris (*.e) file, which is an ASCII text file
formatted for compatibility with STK that includes time, position, and velocity information.
Ephemeris data that is properly formatted can be imported into STK using the STKExternal
Propagator
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Task: Modify Object Properties

1. Change the properties of a vehicle (any type: % ﬂ {).

a. Inthe STK Object Browser, right-click on a vehicle (any type: % % {)
and select Properties (—).

b. Change the vehicle's orbit/route/trajectory:
a. Satellite
i. Selectthe Basic - Orbit page.
ii. Change the desired inputs.

iii. Click Apply to apply the changes and keep the
Properties Browser open.

b. Aircraft
i. Select the Basic - Route page.
ii. Change the desired inputs.

iii. Click Apply to apply the changes and keep the
Properties Browser open.

c. Missile
i. Selectthe Basic - Trajectory page.
ii. Change the desired inputs.

iii. Click Apply to apply the changes and keep the
Properties Browser open.

¢. Right-click on the object in the Object Browser, then select Zoom To.
d. Change the attitude of the vehicle.
a. Satellite
i. Selectthe Basic - Attitude page.

ii. Change the desired Type (e.g. ECF velocity alignment
with radial constraint).

iii. Click Apply to change the properties and keep the
Properties Browser open.

b. Aircraft
i. Selectthe Basic - Attitude page.

ii. Change the desired Type (e.g. Coordinated Turn).
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iii. Click Apply to change the properties and keep the
Properties Browser open.

c. Missile
i. Selectthe Basic - Attitude page.

ii. Change the desired Type (e.g. ECF velocity alignment
with radial constraint).

iii. Click Apply to change the properties and keep the
Properties Browser open.

e. Change the vehicle's color:
i. Select the 2D Graphics - Attributes page.
ii. Selectthe desired Colorinthe drop-down list.
iii. Increase the Line Width thickness.

iv. Click Apply to accept the changes and keep the Properties Browser
open.

f. Change the vehicle's 3D Model.
i. Selectthe 3D Graphics - Model page.
ii. Clickthe ellipse (E) button beside the Model File option.
ii. Browse to the desired 3D model and click Open.

iv. Click Apply to accept the changes and keep the Properties Browser
open.

g. Add vectors to the vehicle
i. Select the 3D Graphics - Vector page.

ii. Enable the Show option on the desired vectors (e.g. Sun Vector,
Moon Vector, SunMoon Angle, Body Axes).

iii. Click Apply to accept the changes and keep the Properties Browser
open.

iv. Right-click on the object and select Zoom To.
h. Add a Data Display for the vehicle
i. Selectthe 3D Graphics - Data Display page.

ii. Enable the Show option on a dynamic data display (e.g. Classical
Orbital Elements).

iii. Click OK to accept the changes and dismiss the Properties Browser.

2. Modify at least one ground site’s sensor (@) Properties.
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a. Click Home View in the 3D Graphics Window, and rotate the globe so you
can see the sensor you will be changing in the 3D Graphics Window.

b. Inthe STK Object Browser, right-click on the ground site's sensor (@) and
select Properties.

c. Change the sensor's field-of-view.
i. Selectthe Basic - Definition page.

ii. Enter the desired Angle value in the textbox (e.g. 90 deg Cone Half
Angle).

ii. Click Apply to accept the changes and keep the Properties Browser
open.

d. Change the sensor's range constraint.
i. Select the Constraints - Basic page.

ii. Enable the Max Range option and enter the desired range
constraint value in the textbox (e.g. 2000 km).

iii. Click OK to apply changes and dismiss the Properties Browser.

AGI Techs Say: You can double-click on an object in the Object Browser to open its properties. If
you want to have the properties page for two objects open, right-click on the second object in the
Object Browser while the properties for the first are still open, and select Properties from the menu
that appears.
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Part 4: Comeute Access

Compute Access

Calculating object-to-object visibility in STK is called Access (n’,). An access is defined FROM one object TO
another object. STK calculates the times that an object can access, or "see," another object based on their
properties and constraints.

E/i‘ Note: The Access tool provides quick links to reports, graphs, and Timeline View.
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Task: Compute Access for a sensor on a Ground Site

1. Compute Access from a ground site's sensor to a vehicle (any type: % %g ﬁ).

C.
d.

Click the Access tool icon (n’) or extend the Analysis menu and select
Access.

On the Access page, click the Select Object... button and select the sensor

(@) on the ground site as the Access For object (From).

Select a vehicle object (ﬁ, %:; ﬁ’) as the To object.
Click the Compute button.

2. Generate an Access (n,) report.

a.

b.

In the Reports section, click Access...

Click the Save as Quick Report (@') button to save the report as a Quick
Report.

i. Click the down arrow on the Quick Report Manager (® I3) to
see the report has been added to the list.
In the report, right-click on an Access Start Time and extend the Start Time

menu to select the Set Animation Time option.

E/‘ Note: If your report says "No Access Found," modify the
vehicle's properties so that the vehicle flies through the sensor
field-of-view.

Bring the 3D Graphics window to the front and look for the access lines
between the objects.

Click the Access tab at the bottom of the Integrated Workspace to bring the
Access Tool to the front.

In the Reports section, click the AER... button to create an AER report.

In the AER Report, look at the Max Range in the Section Statistics. It should
be within the Max Range constraint set earlier (e.g. 2000 km).

3. Create a New Stored View (%).

a.
b.
C

d.

Click the Stored Views (ﬁ,) button on the 3D Graphics toolbar.
Click the New button to create a new Stored view.
Double-click on the View Name "view0" and rename it (e.g. AccessView).

Click OK.

4. Add Access Intervals (5%) to the Timeline View.
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=¢#" Note: Starting with STK 11.1, Access Intervals are automatically added
to the Timeline View when calculating Access. For STK 11.1 or later,
this step is not necessary and may be skipped.

a. If your Timeline View is not open, extend the STK View menu and select
Timeline View.

b. Inthe Timeline View toolbar, select Add Time Components (@).

c. Selectthe access ('-/".)) object on the left.
d. Select Accessintervals in the Components for section on the right.
e. Click OK to add the Access Intervals to the Timeline View and dismiss the

Add Time Components tool.

5. Animate ( b ) the scenario and watch the acces Intervals start and end.

6. Decrease the Max Range constraint and observe the effects of the constraint.

a. Inthe STK Object Browser, right-click on the ground site’s sensor (@) and
select Properties.

b. Selectthe Constraints - Basic page.
C. Enter the desired Max range constraint value in the textbox (e.g. 1000 km).

d. Click OK to apply changes and dismiss the Properties Broswer.

k! .
e. Refresh ) the AER report to see the effects of the updated constraint.

f. Notice any changes to the report and Timeline View after the constraint
was applied.

g. Close the Timeline view.

E/‘ Note: You can generate commonly used Access-specific reports directly from the Access tool
without opening the Report & Graph Manager.

0 Did You Know? Light time delay and the directionality of the signal transmission are considered
when computing the times one object can access another object. Moreover, the effects of
refraction will be considered for objects specifying its use in access in their refraction settings.

L_E}‘ Note: If any of the access objects are changed, the access is automatically computed. But if you
have an access report or graph open, it is not automatically regenerated. You will need to do that
manually.
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Part 5: Reeort & Graehs

Lesson 5.1: Using the Report & Graph Manager
Each STK Object (including Access) has hundreds of associated data providers that STK automatically computes.

The Report & Graph Manager allows a user to quickly generate reports and graphs from a list of commonly used
data providers, called "Installed Styles."

AGI Techs Say: The Quick Report Manager is available from the Analysis menu and an object's
right-click menu.

After generating the reports and graphs, there are a variety of toolbar icons that allow a user to manage their data
(change units, set animation times, save quick reports, save as txt or a *.csv, etc).

Did You Know? You can create your own customized reports and/or graphs inside the Report &
Graph Manager.

Page 26 of 137



Task: Reports and Graphs

1. Click the Report & Graph Manager () icon or extend the Analysis menu and
select Report & Graph Manager.

a. Create an LLA Position report for one of your vehicles.

Vi.

Vii.

Select the desired Object Type (e.g. Satellite, Aircraft, Missile, etc).
Select at least one object for the report that will be generated.

;f Note: Use the Ctrl key to select multiple objects for the
report or graph that will be generated.

Disable the Show Graphs option located in the Styles section. Since
you are only interested in the reports you can hide the graphs from
the list.

Expand the Installed Styles list and select LLA Position.

Click Generate... to display a report for time, latitude, longitude,
and altitude

In the report, click the Save as quick reporticon (@ )8

Close the report.

b. Create an LLA Position graph for one of your vehicles.

Vi.

Vii.

Select the desired Object Type (e.g. Satellite, Aircraft, Missile, etc).
Select at least one object for the report that will be generated.

E/‘ Note: Use the Ctrl key to select multiple objects for the
report or graph that will be generated.

Disable the Show Reports option located in the Styles section. Since
you are only interested in the graphs you can hide the reports from
the list.

Expand the Installed Styles list and select LLA Position.

Click Generate... to display a report for time, latitude, longitude,
and altitude

In the graph, click the Save as quick reporticon (ﬁ ).
Close the graph.

C. Create and formata custom report.

i. Selectthe desired Object Type (e.g. Satellite, Aircraft,
Missile, etc).
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ii. Selectthe Scenario Styles (e.g. STKFundamentals Styles)
folder and click the Create new report style icon (ﬁ‘)

ii. Rename the new report Custom Report and hit Enter on the
keyboard to bring up the Report Style properties.

iv. Replace the asterisk, which means show all, with a partial
data provider name (e.g. Cartesian) and click Filter.

v. Expand () the data provider group (e.g. Cartesian Position).

vi. Ifapplicable, expand (%)) the desired coordinate system (e.g.
Fixed).

vii. Hold the Ctrl key and select the data providers in the list (e.g.
Time, x,y,2).

viii. Click the right arrow to copy the selected items to the Report
Contents list.

ix. Click OK to save the custom report style.

X. Select the new report style (Custom Report) and click
Generate.

ii. Change the units of the report.
Lun]
i. Click the Reports Unit () icon on the reports toolbar or
right-click anywhere in the report and select Report Units...
ii. Selectthe Dimension you want to change on the left.
iii. Selectthe New Unit Value on the right.

iv. Click OK to update the report with the new units.

iii. Click the Save as Quick Report (@ ) button to save the report as a
Quick Report.

iv. Click the Save as .csv (Iﬁ) button to save the report for use in
Microsoft Excel.

Did You Know? The "[scenario name] Styles" directory is different than the "My Styles" directory
in the Reportand Graph Manager. Reports and graphs in the "My Styles" directory are available
for all scenarios the user creates and loads. Those in the scenario styles directory are only
available for that current scenario.

0 Warning: Don't forget to save your work!
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Part 6: Extend STK Caeabilities
Connect and the STK Object Model
The STK Programming Interface offers a wide variety of options to automate and customize STK and to integrate

its technology into custom applications. The Connect module is a library of string commands for STK that are easy
to read, understand, and build.

Did You Know? You can use the commands in the Connect library to easily build applications that
communicate with STK.

Task: Use Examples to Familiarize Yourself with Automating STK

1. Launch the API Demo Utility.

a. Click the HTML Viewer tool icon (‘E') or extend the View menu and select
HTML Viewer.

b. Click Browse (ﬁ).
. Click the Example HTML Utilities option on the left.
d. Browse to STK Automation -> APl Demo -> APIDemoUltility.htm.
e. Select the APl Demo Utility.htm and click Open.
2. Use the examples to familiarize yourself with Connect.
a. Use the examples to familiarize yourself with the STK API:
b. Select Connect/Object Model in the API Demo Utility.
¢. Clickonan Example on the left side of the API Demo Utility.

d. Click Run Code to execute the command.

0 Warning: Don't forget to save your work!
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Part 7: Share Your Work

Lesson 7.1: The Movie Timeline

Moving pictures can depict complex concepts and relationships that would be harder to understand using only
data. The Movie Timeline tool provides features and functions commonly used for movie making.
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Task: Use the Movie Timeline Wizard to Define the Output

1. Launch the Movie Wizard.

a. Extend the View menu, select Toolbars, and click Movie Timeline to add
the Movie Timeline toolbar.

b. Click the Record (@ ) button to launch the Movie Wizard.

2. Use the Movie Wizard to record your movie.

a. Choose the Filename & Format.

Select the format (e.g. Windows Media (* WMV)).

Click Save as... and save the video in the preferred directory (e.g.
MyVideo).

Click Next>>.

b. Choose the Window to record.

Select the Window you want to record (e.g. 1 - 3D Graphics 1 -
Earth).

Click Next > >.

C. Setthe Resolution

Restore your 3D Graphics window (make sure it is not maximized).
Select the desired resolution Preset (e.g. HDTV - 720p).

Click Next >>.

d. Choose the Camera view

e. Define the movie Time & Length

V.

Set the desired Start time.
Set the End time (e.g. ten (10) minutes after the start time).
Set the Movie playback length (e.g. five (5) sec).
« Notice how this changes the Step size / playback speed.
Click the Preview Speed button to preview how the movie will look.
« Alter the Movie playback length and/or Step size until satisfied.

Click Next >>.

f. Define the movie Size & Quality

Select the Render quality (e.g. 3 X 3 - Good quality for Anti-aliasing).

Click Next > >.
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g. Clickthe Begin Record button to record the movie.

h. When the recording is finished, click Yes on the Movie Timeline pop up to
play the recorded movie.

CZML Exporter
This plugin enables you to export supported STK objects and graphics from an STK scenario to Cesium. Supported
objects include 3D models, access lines, covariance ellipsoids, etc. You can find out more about the supported

objects you canimport and even those you can't from our help page
(http://help.agi.com/stk/index.htm#czmlExport.htm)..

Q Did You Know? This requires STK 11.0.1 or later and the CZML Exporter Ul Plugin.
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Task: Enable the CZML Exporter and Export the Scenario
1. Launch the CZML Exporter.
a. Extend the View menu.
b. Extend the Toolbars menu.
¢. Click CZML Exporter to add it to the toolbar.

5‘ Note: If this option is not available, please download the CZML
Exporter https://www.agi.com/product-
explorer/default.aspx#productid=12--catid=0--capid=0--
typeid=3--modeling=0".

d. Open the Export to CZML window.
e. Inthe Cesium panel, specify the model server.

5‘ Note: AGI has already converted all of the default STK models
to gltf, which are hosted on assets.agi.com. If you would like to
convert a custom model, or set up a local model server, please
contact AGI support at support@agi.com.

2. Export CZML.
a. Select Export CZML.
b. Save to a file location on your machine.
C. Click OK on the Success message.
3. Navigate to the webpage.
a. Inaweb browser, navigate to Cesiumjs.org.
b. Click the Demos page.
C. Open the Cesium Viewer.
4. Load the saved scenario to the webpage.
a. Locate the saved CZML file.
b. Drag and drop the saved CZML file on to the Cesium Viewer.

5. Use the animation controls and timeline view to change the time.

o

Zoom to a specific object by double-click on the object.

Save STK Scenarios

STK users have the ability to save their work on their local machine or upload it to a web server-based STK Data
Federate. Associated files for each object and any analysis are generated during the creation process and are
saved in a user-specified location. The files can be packaged as Visual Data Files (VDF) that can be opened in STK
for additional modeling and analysis or presented with STK Viewer.
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Did You Know? The catalog of facilities, satellite, and aircraft provided in the Standard Object
Database (SOD) are hosted on the SDF.

Task: Save the Scenario as a VDF
1. Extend the File menu and select the VDF Setup tool.
2. Enable the Exclude Install Files option.

3. Click the Create VDF button.

AGI Techs Say: Check out AGI's Best Practices for Authoring a VDF to get the most out of your
VDF.
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Become Level 1: STK Certified

Now that you have completed Fundamentals training, you are well-prepared to complete the STK Level 1: STK
Certification test. The STK Certification is the first level of certification and validates your ability to perform
fundamental skills needed to be productive with STK (free version).

What's in the Test?

The STK Certification test consists of one exercise scenario and you have 14 days from registration date to
complete Certification. The following objectives are tested:

o Model Your Systems - KML, Aircraft, Satellite, Sensor, Constraints

o Analyze Your Systems - Access Tool, Report & Graph Manager, Quick Reports
« Visualize Your Data - 3D Models, Stored Views, Timeline View

o Extend STK - Connect and Object Model

o Share Your Work - VDF, STK Data Federate, Movies, Snapshots

Once you earn your STK Certification, you will receive a Level 1: STK Certified gift. Register now on our on our
website (http://www.agi.com/training/#cert).

STK Level 2 - Advanced

STK Level 2 - Advanced training builds off of STK Level 1 - Beginner. You will take simulations from STK
Fundamentals a step further with advanced analysis tools to quantify and measure mission effectiveness.

Evaluation License

Required Product Licenses: This training requires additional licenses to complete. You can obtain the
necessary license for the training by visiting http://licensing.agi.com/stk/evaluation or calling AGI support.

The Level 2 - Advanced Training is a series of tutorials designed to take a user through the STK add-on modules.

Once you have completed these tutorials, you will be ready to take the level 2 STK Master Certification test! Visit
www.agi.com/training/ (free for U.S. and Canada). Upon registration for the L2 Master Certification, you will receive
an email confirmation with an attachment for a 14 day demo license. This license provides you access to all the
modules needed to complete the certification.
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Tutorial License Required

Add Fidelity with STK Pro Learn how to add terrain and imagery to the scenario. STK Pro

Customize Analysis with Analysis Workbench Learn how to use Analysis
Workbench to build custom geometric, temporal, and logical operations through Pro, AWB
STK.

Create an AzEl Mask from Images Learn how to display the sensor obscuration

from a mask file. Pro
Compute Coverage Over Regions Learn how to analyze global and regional

; . Pro, Cov
coverage provided by various assets.
Build a Volumetric Object Learn how to build a volumetric object. Pro, AWB

Perform Trade Studies with Analyzer Learn how to use Analyzer to automate STK

. . Pro, Analyzer
trade studies and parametric analyses. O, Analyze

Evaluate Communication Links Learn how to define and analyze detailed

L Pro, Comm
communication systems.
Analyze Radar Systems Learn how to build radar system models to simulate and Pro Radar
analyze system performance. '
Integrating STK with Matlab Learn how to control STK through an external .
T Integration
application like Matlab.
Integrating STK with Python Learn how to control STK through an external .
T Integration
application like Python.
Integrating STK with Excel Learn how to control STK through an external .
Integration

application like Excel.

Model Aircraft Missions with Aviator Learn how to model a sequence of curves

parameterized by well known performance characteristics of aircraft. Pro, Aviator (AMM)

Assessing the Threat of a Collision Learn how to use CAT to avoid a satellite

. Pro, CAT
collision.

Design Trajectories with Astrogator Learn how to use Astrogator to place a

satellite in orbit. Pro, Astrogator

E‘ Note: For the STK 10 version of this training, visit
http://help.agi.com/StartTraining/StartTraining1013.htm
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Part 8: Add FideIitz with STK Pro

Required Product Licenses: This training requires additional licenses to complete. You can
obtain the necessary license for the training by visiting http://licensing.agi.com/stk/evaluation or
calling AGI support.

STK Pro introduces more sophisticated modeling through advanced access constraints, flexible sensor shapes,
complex visibility links, more object tracks, and digital terrain data. STK Pro allows users to:

« Constrain model behavior based on motion and geographic limitations including analytical and visual
terrain.

« Define advanced sensor fields-of-view and fields-of-regard using custom geometry and pointing.

» Build system networks using defined groups or sequential, multi-link relationships called "chains".

Analytical and Visual Terrain

AGI works with several sources of terrain data. When used with STK, terrain exploits sophisticated multi-
dimensional interpolation algorithms to provide accurate 360 degree azimuth-elevation masks for access
calculations from any point on the Earth's surface. These algorithms also provide altitude information for user-
defined facilities, places, and targets. Terrain, when used visually, allows a vivid 3D visual depiction of the Earth's
true surface relief and its effect on accesses and visibility. Terrain, when used for analysis, includes terrain elevation
data in the computation of an azimuth-elevation mask; the position of a facility, place or target; altitude reference
for an aircraft, facility, place, ship, or target; height above ground for a facility, place or target; boundary wall for an
area target or line target.
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Task: Add Terrain and Imagery to Determine its Impact on Line of Sight Visibility

1. Add Terrain and Imagery.

a. Create a new scenario with the default time period.

Click create a Scenario (ﬁ).

In the New Scenario Wizard set the following options:
a. Name the scenario (e.g. "STK_Pro").

b. Define the analysis start and stop times or accept the
defaults.

c. Click OK.

b. Add analytical terrain to the scenario and disable Terrain Server.

iv.

Right-click on the scenario (ﬁ) and open the Properties (El).
Select the Basic - Terrain page.
Disable the Use terrain server for analysis option.

Click the Add button and browse to the terrain data file (e.g.
hoquiam-e.dem).

a. The example file is located at <Install
Directory>\Data\Resources\stktraining\samples

b. Select USGS DEM (DEM) (*.dem) in the file type drop
down list.

Click OK to apply changes and dismiss the Properties Browser.

Certral Bocy: [Eath -]
Use.

c. Convert the terrain data file to a terrain inlay file (*.pdtt).

Click the Utilities menu and select Imagery and Terrain
Coverter...

. Select the Terrain Region page.

ii. Selectthe Terrain Source previously loaded in the scenario from the

drop-down list (e.g. hoquiam-e.dem).

In the Output data section, click the ellipsis (E) button to select the
Output Data Directory (e.g. current scenario directory).

Enter a filename (e.g. SaintHelens) in the Filename text field.
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Vi.

Vii.

i. Click the Globe Manager (ﬁ) icon or click the View menu and select
Globe Manager.

Click Convert.

Click Close to dismiss the Imagery and Terrain Converter.

Single Image
Multiple Images
Terrain Region ™

Cone

Input Data

Temain Source [CodeSamplu\SharedHacurca\Swnancs\Evmz\Hoqmame dem vl E]

South West Morth East
Source Bxtent: 46 deg @) -123deg  [#7) 47deg [ 122deg &)
[ Custom Region: |46 deg E)|[123des )[40 B|[22deq &)
Output Data
Directory: C:\Users‘rdeyoung’\Documents\STK 10%Imageny TemainConversion B
Filename: .éaint‘l-‘l‘a‘l‘ans pd-tt
Delete Intermediate Temain File

d. Add visual terrain to the scenario.

E‘ Note: You can drag and drop .pdtt files directly onto
the STK globe.
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ii. Clickthe Add Terrain/Imagery ( ﬂ ) button or right-click Earth in
the Globe Manager and select Add Terrain/Imagery...

i. Selectthe *.pdttfile (e.g. SaintHelens.pdtt) from the Path
drop-down list.

ii. Click Open.
iii. When prompted, click Yes to enable terrain for analysis.

iv. Right-click on the *.pdtt file in the Globe Manager and
select Zoom To.

& Globe Manager: Open Terrain and Imagery Data

Path: |C:\Userslydeyoung\Documents STK. 10\imageryTerrainConversion - E

| LocalFiles
|

Globeserver

@

Bing™ Maps

=

Terrain Server

1Ttems

Selected: SaintHelens.pdtt

Filter by Type: | All Supported Types. -

o) [ ] [ rn ]

( )

—)
Ef Note: Click the Flashlight ( / )iconon
the 3D Graphics Window menu bar to

brighten the terrain file if it appears to
be nighttime at Mount Saint Helens.

Tf Note: If you have an active internet

=
connection ( & ), your imagery should
be clear when zoomed in. If you do not

have an active internet connection, you
caninstead load the preinstalled
imagery using the Add Terrain/Imagery
procedure and opening the St
Helens.jp2 imagery file located at
C:\Program Files\AGN\STK

T1\STKData\VO\Textures.
L J

2. Ensure that Ground Sites Consider Terrain.

a. Model a ground site (any type: I"*r_-'} ﬁ 9) on the terrain region using
one of the available insert methods (examples below).
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i. Inserta Place (@I ) and Search by Address (requires Internet (

% ) (e.g. Mount St. Helens, WA). If you do notinternet access,
insert a Place and Define Properties, entering a Latitude of
46.19120 deg and a Longitude of -122.19440 deg.

ii. Inserta ground site (any type: q} Q @) on the terrain
region by using 3D Object Editing.

b. Ensure the ground site (any type: Q ﬁ @) considers terrain height for
its altitude.

i. Enable the Use terrain data for altitude option.

ii. Click OK to apply the changes and dismiss the Properties
Browser.

3. Create and Display Terrain Obscuration.
a. Right-click on the ground site (e.g. Mount_St_Helens_WA) and select
Properties (El).
b. Define an azimuth-elevation mask and use it for an access constraint.
i. Selectthe Basic - AzEIMask page.
ii. Use Terrain Data.
ii. Enable Use Mask for Access Constraint.
iv. Click Apply to apply the changes and keep the Properties open.
5/‘ Note: By enabling the Use Mask for Access Constraint
option, the Az-El Mask constraints is enabled on the
Constraints — Basic page.
c. Display the azimuth-elevation mask at the ground site.
i. Selectthe 2D Graphics - AzEIMask page.
ii. Enable the Show option beside the At Range option.
ii. Enter a max range for the mask display (e.g. ten (10) km).
iv. Click OK to accept the changes.

d. Mouse around the 3D Graphics window to take a look at the azimuth-
elevation mask display.

4. Ensure a Moving Vehicle Considers Terrain.

[
a. From the Insert STK Objects (ﬂg) tool, select Ground Vehicle (ﬁ) and
choose the Define Properties method.

b. Ensure the vehicle considers terrain along its route.
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i. Selectthe Basic - Route page.
ii. SelectTerrain as the Altitude Reference.
iii. Seta Granularity type (e.g. 0.01 km).
iv. Select Terrain Height as the Interp Method.
C. Insertwaypoints (examples below):
i. Type in waypointvalues.

i. Onthe Basic - Route page, click Insert Point twice to add
two waypoints manually.

ii. Enter values for the first waypoint (e.g. Lat = 46.23 deg, Lon =
-122.23 deg).

ii. Enter values for the second waypoint (e.g. Lat = 46.19 deg,
Lon =-122.13 deg).

iv. Click OK to dismiss the Properties browser.
ii. Use 3D Object Editing..
i. Make sure the ground vehicle's Properties Browser is closed.

ii. Use the 3D Object Editing tool to model the ground
vehicle's route.

ADD: | sHier | + %

MODIFY: --%} * % + .*.
y
REMOVE: | sHIFT +"wl\[} %

5. Determine if Terrain is Obscuring the View.

a. Compute Access (n’) between the ground site (I:‘*_:'I ﬁ 9) and ground

vehicle ) and generate an Access report.

i. Open the Access (n’) tool.

ii. Onthe Access page, click the Select Object... button and select the
ground site (e.g. Mount_St_Helens_WA) as the Access For object
(From).

iii. Selectthe ground vehicle ﬂ) as the To object.
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iv. Click the Compute button.

v. Click Access... in the Reports section of the Access tool.

o
b. Add intervals (%) to the Timeline View.

i. Inthe Timeline View toolbar, select Add Time Components (@).

ii. Add the ground vehicle's availability time span to the Timeline View.

i. Select the Ground Vehicle ﬁ) on the left.

ii. Select AvailabilityTimeSpan in the Components for
section on the right.

iii. Click Apply to add the availability interval to the Timeline

View.

c. Animate ( ' ) and mouse around the 3D Graphics window to visualize
when the terrain obstructs access.

d. Use the Slide Bar to scroll through the ground vehicle's route and visualize
when the terrain obstructs access.

Chain Objects

STK Pro allows users to build system networks by defining sequential, multi-link relationships. Multi-hop links are
modeled by Chain (ﬁﬂ) objects in STK. Chains model a list of objects (either individual or grouped into
+y

o,
Constellations ( %) in order of access.
\

.
'.I-Ju'

0 Did You Know? A Constellation ( ) object allows you to group a set of related objects, such as
a group of facilities or satellites, into a single unit called a constellation. The objects that comprise

the constellation define it.

A Chain (ﬁP’) object enables you to assign objects (either individual or grouped into
constellations) to the chain and define the order in which the objects are accessed. You can

compute accesses to an entire group of assets using the Chain object.
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Task: Create a Multi-hop Link

1. Model a communications relay (ﬁ) using one of the available insert methods
(examples below:)

a. Inserta satellite (%) by searching the Standard Object Database (e.g.
ANIK G1).

b. Inserta satellite (%) by designing an orbit with the Orbit Wizard (e.g.
Type = Geosynchronous), Subsatellite Point = -90 deg).

2. Model the Multi-hop communications link using a Chain (ﬁP.) object.

]
a. From the Insert STK Objects (ﬂg) tool, insert a Chain (;;P’) object using the
Define Properties method.

b. Selectthe Basic - Definition page.

c. Define the order in which the objects are accessed.

[
i. Move () the first object in the chain (e.g. Mount_St_Helens_
WA) to the Available Objects list.

ii. Repeatthe previous step until all chain objects are in the
Available Objects list in the correct order (e.g. Mount_St_
Helens_WA - Satellite - Ground Vehicle).

d. Click OK to accept the changes and dismiss the Properties Browser.

3. Inthe STK Object Browser, right-click on the Chain object and extend the Chain
menu. Select Compute Accesses to compute Chain access.

4. Generate a Complete Chain Access report.

a. Inthe STK Object Browser, right-click on the Chain object and click Report
& Graph Manager.

b. Select Complete Chain Access reportin the Installed Styles list.

c. Click Generate... to display the complete chain access intervals.

0 Warning: Don't forget to save your work!
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Part 9: Create an AzEl Mask from a 3D Model

Required Product Licenses: This training requires additional licenses to complete. You can
obtain the necessary license for the training by visiting http://licensing.agi.com/stk/evaluation or
calling AGI support.

AzE| Mask Tool

The AzEl Mask tool generates static body masking (*.bmsk) files which are used to restrict visibility to a sensor. The
term body masking refers to line-of-sight obstruction caused by the three-dimensional model of the parent object
of the sensor or other objects in the scenario. The body masking files contain obscuration contours which are
generated based on six views generated from the point of view of an observer at the location of the sensor.

The six views can be thought of as containing projections of the obscuration objects onto the faces of a cube
centered at the sensor. Contours are constructed using an edge detection algorithm and stored along with
information describing the orientation of the view from which they were constructed. To affect visibility
computations, set the body masking file as the AzEl Mask file for the sensor and enable the sensor AzEl Constraint.
You can combine the terrain obsuration from the Add Fidelity with STK Pro exercise with 3D model obscuration.
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Task: Create a Sensor AzEl Mask

1. Create a new scenario with the default time period.

a. Click the Create a new scenario (ﬁ) button.

b. Inthe New Scenario Wizard, set the following options:
o Enter a name for the scenario (e.g. STK_SensorAzEIMasking).
o Use the default Start time.
o Setthe Stop time to one (1) second.

c. Click OK.

2. Add visual and analytical terrain to the scenario.

a. Right-click on SensorAzEIMasking (ﬁ) and select Properties (El).

b. Select the Basic - Terrain page.
c. Disable the Use Terrain Server for analysis option.

d. Click OK to apply the changes and dismiss the Properties Browser.

e. Inthe 3D Graphics window toolbar, click the Globe Manager (ﬁ). You can
also extend the View menu and select Globe Manager.

g/i‘ Note: You can drag and drop .pdtt files directly onto the STK
globe.

f. Clickthe Add Terrain/Imagery (ﬁ) button or right-click Earth in the Globe
Manager and select Add Terrain/Imagery.

i. Ensure Local Files is selected.

ii. Clickthe ellipsis (E) button and browse to C:\Program
Files\AGNSTK 11\Data\Resources\stktraining\Imagery.

iii. Open StHelens_Training.pdtt.
iv. When prompted, click Yes to enable terrain for analysis.

V. Right-click on the *.pdtt file in the Globe Manager and select Zoom
To.

3. Ensure a ground site considers terrain.

a. Model a Place (I:;:I ) object on the terrain region using the From City
Database method.

i. Insert Morton, Washington using the From City Database option.

b. Ensure Morton considers terrain height for its altitude.

Page 46 of 137




i. Right-clickon Morton (I"‘r_-':I ) and select Properties (El).
ii. Selectthe Basic - Position page.
ii. Ensure the Use terrain data for altitude option is enabled.
iv. Enter 20 ft (feet) in the Height Above Ground field.
v. Click Apply.
C. Define an Azimuth-elevation mask and use it for an access constraint.
i. Selectthe Basic - AzEIMask page.
ii. Enable the Use Terrain Data option.
ii. Enable the Use Mask for Access Constraint option.
iv. Click OK to apply the changes and dismiss the Properties Browser.

4. Model a sensor on Morton.

]
a. Inthe Insert STK Objects (ﬁﬁ) tool, select Sensor (@
b. SelectInsert Default as the Select A Method option.

. Click the Insert... button to bring the Select Object window to the front.
d. Select Morton in the Select Object window.

e. Click OK.

f. Rename the sensor SatTracker.

5. Ensure SatTracker properties uses the parent object's AzEIMask file.

a. Right-click on SatTracker (@) and select Properties (El).
b. Select the Basic - Definition page.
C. Setthe Sensor Type to Complex Conic.
d. Setthe Half Angles - Outer to 180 deg.
e. Click Apply.
f. Select the Constraints - Basic page.
g. Enable the Az-El Mask option.
h. Click Apply.
6. Display Terrain Obscuration.
a. Select the 2D Graphics — Projection page.
b. InField of View, enable Use Constraints.

C. Select AzEIMask.
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d. Click Apply.

e. Selectthe 3D Graphics —Projection page.

f. Set Space Projection to 50km.

g. Click OK to apply the changes and dismiss the Properties Browser.

h. Zoom To Morton and use the mouse to view the AzEIMask constraints.

7. Model an obscuring object.

a. Inthe Insert STK Objects tool, select Facility (ﬁ.
b. Select Insert Default as the Select A Method option.

¢. Rename the Facility object "Building.”

d. Zoom To Morton (I;:I ).

e. Use the 3D Object Editing tool to place Building in the middle of the white
structure across the street from Morton.
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ADD: | swier | + @

MODIFY: + @ + 41..
y

REMOVE: | SHIFT +*:;¥§+ @

8. Create a Sensor AzEl Mask.

a. Right-click on SatTracker (@) and extend the Sensor menu.
b. Selectthe AzEl Mask option.

C. Inthe AzEl Mask tool, locate the Obscuring Objects field and select
Building.

d. Inthe File: field, click the ellipsis (E) button.

e. Ensure the path goes to your scenario folder.

f. Enter MyBodyMask in File Name.
g. Click Save.
h. Change Window Dim: to 500.

i. Click Apply.

J- Ensure the AzEl Mask tool is not obstructing the Az/El Mask View window.
k. Click Compute.

|. Close the AzEl Mask tool and the Az/El Mask View window.

9. Ensure the Sensor uses the body mask file (*.bmsk) during access calculations.

Page 49 of 137




g.
10. Display Body Mask File Obscuration.
a.

b.

Right-click on SatTracker (@) and select Properties (El).
Select the Basic —Sensor AzEl Mask page.

Enable the Use MaskFile option.

Click the Mask File: ellipses (E) button.

Select MyBodyMask.bmsk and click Open.

Enable the Use Mask for Access Constraint option.

Click Apply.

Select the 2D Graphics — Projection page.

In Field of View, use the Ctrl key to select SensorAzEIMask and ensure
AzEIMask is still selected.

Click OK to apply the changes and dismiss the Properties Browser.

Zoom To Building and view the obscuration.

[0 Warning: Don't forget to save your work!
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Part 10: Customize Analxsis with Analzsis Workbench

Required Product Licenses: This training requires additional licenses to complete. You can
obtain the necessary license for the training by visiting http://licensing.agi.com/stk/evaluation or
calling AGI support.

Using Analysis Workbench (B), you can build custom geometric, temporal and logical operations through a
graphical user interface to extend STK's modeling and analysis. These tools serve as the building blocks for
advanced analysis through the click of just a few buttons. Use the STK Analysis Workbench to:

« Model non-standard system components

« Define new measures of effectiveness

» Create custom calculations without any scripting

« Trigger events based on temporal, geometric and logical function

The Time, Vector Geometry, and Calculation Tools are application-wide tools designed to streamline, organize,
and extend the fundamental computational capabilities of STK.

AGI Techs Say: When creating components for objects in Analysis Workbench, itis a good idea to
consider what objects those components should logically be created for (e.g. an angle with two
vectors originating from an object that should belong to that object.)

Vector Geometry Tool

Use the Vector Geometry Tool (VGT) to build custom geometric models from any combination of out-of-the box

or user-created vectors (), points (O), angles (Tﬁw), planes ('ﬁ»), axes (%’), and coordinate system ("E.':’)

components.

« Define unique system access constraints
« Build custom platform and payload orientations
o Importand exportdata in any reference frame

Did You Know? AGI currently holds a patent for VGT called “Method and Apparatus for Creating
Elements and Systems for Description of Position and Motion of Bodies in Three-Dimensional
Space to Support Orbital Maneuver Analysis.”
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Task: Create a Targeted Vector from a Fixed Location to a Vehicle

1. Create a new scenario.

a. Click the Create a Scenario (&) button.
b. Inthe New Scenario Wizard, set the following options:
i. Enter a Name for the scenario (e.g. STK_AWB).
ii. Define the analysis start and stop times or accept the defaults.

c. Click OK.

2. Model a ground site (any type: q} ﬁ @) using one of the available methods:
(examples below)

a. Inserta Place (I"‘F_-':I ) and Search by Address (require Internet(?
Mount St. Helens, WA).

) (e.g.

3. Model a moving vehicle (%, ‘E:'? ﬁ) that has visibility to the ground site using
one of the available methods (examples below).

a. Insertan aircraft (éi-;) by clicking the waypoints in the 3D Graphics
window (e.g. create a route around Mount St. Helens).

4. Compute Access between the moving vehicle and ground site.

a. Open the Access tool (n’!).

b. On the Access panel, click the Select Object... button and select the
moving vehicle as the Access For object (From).

C. Select the ground site as the "To" object (e.g. Mt. St. Helens).
d. Click the Compute button.
e. Click Access... in the Reports section to generate an Access report.

f. If there is no access, modify the vehicle's orbit, route, or trajectory.

5. Click the Analysis Workbench (S) icon or extend the Analysis menu and select
Analysis Workbench.

6. Create a displacement vector (#) from the moving vehicle to the ground site.
a. Select the Vector Geometry tab.

b. Select the moving vehicle (e.g. Aircraft1) to make that object the Parent
object.

c. Click the Create New Vector (ﬁ) button.

d. Ensure the Type to Displacement (default).
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Enter a name for the vector (e.g. ToMtStHelens) in the Name field.

If the Parent is not the moving vehicle (e.g. Aircraft/Aircraft1), click the
Select... button to choose the correct parent.

Click the ellipsis (E) button to select the Origin Point.
i. Select the moving vehicle (e.g. Aircraft1).
ii. Select Center on the list.
iii. Click OK.
Click the ellipsis (E) button to select the Destination Point.
i. Selectthe ground site (e.g. Mount_St_Helens_WA).
ii. Select Center in the Points For: list.
iii. Click OK.

Click OK to save the vector properties and dismiss the Add Geometry
Component window.

. Create anangle (Té'b) between the targeted vector and the moving vehicle's Body
Z vector.

a.

On the Vector Geometry tab, select the moving vehicle (e.g. Aircraft1) and
make it the Parent object.

Click the Create New Angle (Tﬁ'b) button.

If the Type is not set to Between Vectors..., click the Select... button to
select Component Type.

Enter a vector name (e.g. pointingAngle) in the Name field.

If the Parent is not the moving vehicle (e.g. Aircraft/Aircraft1), click the
Select... button to choose the correct parent.

Click the ellipsis (E) button to select the From Vector.
i. Select the moving vehicle (e.g. Aircraft1) on the left.

ii. Selectthe new Displacement Vector (e.g. toMtStHelens) in the My
Components directory on the right.

iii. Click OK.
Click the ellipsis (E) button to select the To Vector.
i. Select the moving vehicle (e.g. Aircraft1) on the left.
ii. Click to expand the Body axes on the right, and select the Z Vector.
iii. Click OK.
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h. Click OK to save the angle properties and dismiss the Add Geometry
Component window.

8. Display the custom vector components for the moving vehicle in the 3D Graphics
window.

a. Open the moving vehicle's Properties... (El).
b. Selectthe 3D Graphics - Vector page.

C. Click the Add... button.

i. Selecta desired vector or angle (e.g. toMtStHelens Vector, Body Z
Vector, pointingAngle Angle).

ii. Clickthe Insert button to add it to the selected list.

iii. Repeatthe previous steps until all components are in the Selected
List.

iv. Click OK to dismiss the Add Geometry Component Window.
d. Enable the Show option to display the desired components (e.g. Body
Axes, toMtStHelens Vector, Body Z Vector, pointingAngle Angle).

5‘ Note: To also display the angle value in the 3D Graphics
window, click on the angle component in the list and enable the
Show Angle Value option.

e. Click OK to apply the changes and dismiss the Properties Browser.
f. Right-click on the object and select Zoom To to see the object and the

vectors.

E/i‘ Note: Vectors are displayed using the objects 3D Graphic - Vector page. If
the vectors or axes are not listed, you can add them.

Calculation Tool

Use the Calculation tool to combine system data with algebraic, functional, and calculus operations to extend
models and define new data providers with custom algorithms from 20 mathematical operations.

Operations available in the Calculation tab of the Analysis Workbench include:

o Scalar calculations ()

« Conditions ()
« Parameter sets ()

Did You Know? Calculation Components are time-dependent quantities that produce
computational results and can be reported, graphed, transformed, and analyzed.

Page 54 of 137



Warning: You need to have completed the Vector Geometry Tool lesson before you attempt the
following tasks.
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Task: Create a New Condition for when the Angle between the moving vehicle and a fixed

location

1.

Add a Scalar Calculation ( ) that references the angle created in the lesson
above.

a. Click to select the Calculation tab.

b. Select the moving vehicle (e.g. Aircraft1) to make it the Parent object.

c. Click the Create New Scalar Calculation ( ).

d. Ifthe Type is notsetto Angle, click Select... to select Angle as the
Component Type.

e. Enter a scalar name (e.g. pointingAngleScalar) in the Name field.

f. If the Parent object is not the moving vehicle (e.g. Aircraft/Aircraft1), click
Select... to choose the correct parent object.

g. Clickthe ellipsis (E) button to select the Input Angle.
i. Select the moving vehicle (e.g. Aircraft1) on the left.

ii. Selectthe custom angle (e.g. pointingAngle) in the Angles for: liston
the right.

iii. Click OK.

h. Click OK to save the scalar properties and dismiss the Add Calculation
Component window.

create new calculations using various functional operations as

ﬁ AGI Techs Say: Scalar calculations, in particular, allow users to
well as calculus, e.g., differentiation and integration.

2. Add a Condition () that references the angle created in the lesson above.

a. Onthe Calculation tab, select the moving vehicle (e.g. Aircraft1) to make it
the Parent object.

b. Click the Create New Condition () button.

c. Ifthe Type is not set to Scalar Bounds, click Select... to choose Scalar
Bounds as the Component Type.

d. Enter a condition name (e.g. above80degrees) in the Name field.

e. If the Parentis not the moving vehicle (e.g. Aircraft/Aircraft1), click Select...
to choose the correct Parent object.

f. Click the ellipsis (E) button to select the Origin Point.
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i. Select the moving vehicle (e.g. Aircraft1) on the left.

ii. Selectthe custom scalar (e.g. pointingAngleScalar) in the Scalar
Calculations for: list on the right.

ii. Setthe Operation to Above Minimum.
iv. Setthe Minimum option to the desired value (e.g. 80 deg).
v. Click OK.

g. Click OK to save the condition properties and dismiss the Add Calculation
Component window.

3. Create a report that lists the times when the defined condition is met.

AGI Techs Say: The Quick Report Manager is available from the
Analysis menu and an object's right-click menu.

a. Onthe Calculation tab, right-click on the new condition (e.g.
above80degrees) and select Report/Graph.
b. Click the Report/Graph button to generate the report.
C. Click Close to dismiss the Calculation Report/Graph window.
4. Add the condition to the Timeline View.

a. If your Timeline View is not open, extend the View menu and select the
Timeline View.

b. Select Add Time Components (@) in the Timeline View toolbar.
c. Select the STK moving vehicle object (e.g. Aircraft1).
d. Select AvailabilityTimeSpan in the Components For section. Click Apply.

e. Expand the condition (e.g. above80degrees) and select any
SatisfactionIntervals.

f. If the moving vehicle's availability time span is shorter than the scenario
time period, right-click on the vehicle's availability time span interval and
select Center.

E‘ Note: Use the Start Time of the SensorOnTimes interval to set
the reference time instant.

Time Tool

Use the Time tool (inside the Analysis Workbench) to create and manage any time instance ( 'E'), interval () or

interval collection (8%) as a named entity for use as a model property or calculation object. Time components can
be added to the Timeline View and used anywhere that a time interval is relevant within STK. Relevant locations

within STK could be display times for a sensor or temporal constraints for an analysis. With the Time Tool, users
can:
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« Create event triggers using logical operations, time shifts, times of extremum, satisfaction times, etc.
« Manage system simulation using relative mission times
» Visualize any time component in a dedicated window

AGI Techs Say: Time components can be added to the Timeline View which provides a new way
to display and operate on time components. They can be added via the Timeline View menus or
dragged and dropped into the Timeline View from the Analysis Workbench window.

\
Did You Know? Time is fundamental to most computations in STK and is used in reporting and
graphing. Time is also used in static and dynamic visualizations as well.

J

\
Warning: You need to have completed the Calculation Tool lesson before you attempt the
following tasks.

J
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Task: Create a Custom Interval Set that defines Tracking Opportunities

(T
1. Add an Interval List (=) that defines the times the condition created above is
satisfied.

a. Click to select the Time tab.

b. Select the moving vehicle (e.g. Aircraft1) to make it the Parent object.

i
c. Click the Create New Interval List (==).

d. Click Select... to choose Merged as the Component Type. Click OK.
e. Enter anInterval List (e.g. visibilityTimes) in the Name field.

f. If the Parent object is not the moving vehicle (e.g. Aircraft/Aircraft1), click
Select... to choose the correct parent.

g. Select the two Components in the Time Components field.
h. Click OK.
i. Click the Add... button and add the Access Intervals between the moving

vehicle and the ground site as the first Time Component.

E‘ Note: The Access Intervals time component is found under
Access objects.
i. Select the Access between the moving vehicle and the ground site.
ii. Select AccessIntervals in the Components For list.
iii. Click OK.

J- Clickthe Add... button and add the previously created condition (e.g.
above80Degrees) as the second Time Component.

i. Select the moving vehicle (e.g. Aircraft1).

ii. Expand the condition (e.g. above80Degrees) and select
SatisfactionIntervals in the Components For list.

iii. Click OK.
k. Setthe Operation to Minus.

—¢" Note: Subtracting intervals is done using the Merged interval
list type.

. Click OK to save the scalar properties and dismiss the Add Calculation
Component window.

D
2. Add the interval (=) to the Timeline View.
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a. If your Timeline View is not open, extend the STK View menu and select
Timeline View.

b. Inthe Timeline View toolbar, select Add Time Components (@).
c. Select the STK moving vehicle object (e.g. Aircraft1).

d. Select the new interval list (e.g. visibilityTimes). Click OK.

0 Warning: Don't forget to save your work!
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Part 11: Comeute Coverage Over Regions

Required Product Licenses: This training requires additional licenses to complete. You can
obtain the necessary license for the training by visiting http://licensing.agi.com/stk/evaluation or
calling AGI support.

STK Coverage

The STK Coverage module allows you to analyze the global or regional coverage provided by one or more assets
(facilities, vehicles, sensors, etc.) while considering all access. Specific results are generated based on detailed
access computations performed to user-defined grid points within an area of coverage.

Case Study

There are two case studies that showcase AGl's Coverage capability: Missile Flight
Test Planning and Analysis with STK and Joint Navigation Warfare Center's
Common Operating Environment.

Using STK Coverage you can:

o Selectregions of interest.

« Define coverage assets (satellites, ground facilities, etc.).
« Define the time period of interest.

« Determine and report measures of coverage quality.

Page 61 of 137



Task: Define Coverage and Compute Accesses from the Assets to the Grid

1. Create a new scenario with the default time period.

a. Click the Create a Scenario (&) button.

b. Inthe New Scenario Wizard, set the following options:
i. Enter a Name for the scenario (e.g. STK_Coverage).
ii. Define the analysis start and stop times or accept the defaults.

c. Click OK.

2. Model an Area Target ) using one of the available methods.
o Insertan Area Target using the Select Countries and US States method.
a. Select United_States in the list on the left..
b. Click Insert.

C. Click Close to dismiss the Select Countries and US States window.

3. Model atleast one moving vehicle (ﬁ, Eg ﬁ’) that passes over the area target
during the analysis time using one of the available methods.

a. Insert a Satellite (%) using the Define Properties method and click OK to
accept the default parameters and dismiss the Properties Browser.
b. Insertan Aircraft (%g) by typing in waypoint values.
Example waypoint values
o Firstwaypoint: Lat = 39 deg, Lon = -120 deg.
« Second waypoint: Lat = 40 deg, Lon = -77 deg.

4. Model a default sensor (@) on the moving object.

a. Inthe Insert STK Objects (ﬁg) tool, select sensor (@).
b. Select the Insert Default as the Select A Method option.
C. Click the Insert... button.

d. Select the moving vehicle in the Select Object window.

e. Click OK.

5. Inserta Coverage Definition (’&) using the Define Properties method.
'__:" Note: You may need to add the Coverage Definition object to
the Insert STK Objects tool. To do this, click the Edit
Preferences button and select it from the New Object tool.
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i. Define the Coverage Definition.

ii. Use the area target ) to define the grid.

i. Onthe Basic - Grid page, set the Type option to Custom
Regions.

ii. Clickthe Select Regions... button.

[
iii. Move () the area target (e.g. United States) in the Area
Targets list to the Selected Regions field. You can also

double-click the area target you'd like to move.
iv. Click OK to dismiss the Select Regions window.

v. Click Apply to apply changes and keep the Properties
Browser open.

iii. Define the grid Point Altitude.
i. On the Basic - Grid page, locate the Point Altitude section.

ii. Selectthe Altitude above Terrain option from the drop-
down list.

iii. Keep the altitude at the zero (0) km default value.

iv. Click Apply to apply changes and keep the Properties
Browser open.

iv. Assign the vehicle(s) as Assets.
i. Select the Basic - Assets page.

ii. Click the object(s) in the Assets list (e.g. Aircraft1 or Satellite1)
and click Assign.

iii. Click Apply to apply changes and keep the Properties
Browser open.

v. Disable the option to Automatically Recompute Access.
i. Select the Basic - Advanced page.
ii. Disable the Automatically Recompute Access option.

iii. Click OK to apply changes and dismiss the Properties
Browser.

vi. Right-click the Coverage Definition (‘&) object in the Object
Browser, select the CoverageDefinition menu, and click compute

Accesses.

AGI Techs Say: Constraints can be applied to each grid point by selecting an object or the
instance of an object. If you select an object, the constraints set for the object are also applied to
used by all points within the grid.
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Coverage Quality

While the coverage definition (ﬁ ) defines the problem, the Figure(s) of Merit (x) allows you to evaluate the
quality of coverage provided by the selected set of assets (defined for the coverage definition object) over the

coverage area and then provide a method for summarizing and viewing the resultant data.

To evaluate coverage quality, you will first need to set basic parameters that determine the way in which quality is
computed, which involves:

« Choosing the method for evaluating the quality of coverage provided.
o Setting measurement options.
« Identifying the criteria needed to achieve satisfactory coverage.

Did You Know? Figures of Merit can exhibit two types of behavior: dynamic and static. The
dynamic behavior of a Figure of Merit allows you to compute values corresponding to a specific
time. Not all Figures of Merit can exhibit dynamic behavior. Those which do not exhibit dynamic
behavior are not able to compute time-dependent information.
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Task: Measure the Quality of Coverage

1. Create a simple Coverage Figure of Merit.
a. Attach a default Figure of Merit (x) to the Coverage Definition (&).
. . ﬁg . . ﬁ"
i. Inthe Insert STK Objects tool @), select Figure of Merit (F% ).

E‘ Note: You may need to add the Figure of Merit object
to the Insert STK Objects tool. To do this, click the Edit
Preferences button and select it from the New Object
tool.

ii. Select Insert Default from the Select A Method list.

iii. Click the Insert... button.

iv. Selectthe Coverage Definition (&) object in the Select Object
dialog.

v. Click OK.

b. Right-click on the Figure of Merit in the Object Browser, and rename the
object (e.g. FOM_SimpleCoverage).

c. Display the Static Graphics only.

i. Right-click on the Figure of Merit (x) and select Properties (El).
ii. Selectthe 2D Graphics - Animation page.

iii. Disable the Show Animation Graphics option. By default, both
animation and static graphics are displayed.

iv. Click OK to accept the changes and dismiss the Properties Browser.

d. Generate a Percent Satisfied report for the Figure of Merit (x).

i. Right-click on the Figure of Merit (x) in the Object Browser and
select Report & Graph Manager.

ii. Disable the Show Graphs option located in the Styles field. You are
only interested in the reports so you can declutter the Styles window
by removing the graphs.

iii. Expand (#) the Installed Styles directory and select Percent
Satisfied.

iv. Click Generate... to display the percent and area satisfied.

e. Display Animation Graphics.
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i. Right-click the Figure of Merit (x) and select Properties (El).
ii. Selectthe 2D Graphics - Static page.
iii. Disable the Show Static Graphics option.
iv. Selectthe 2D Graphics - Animation page.
v. Enable the Show Animation Graphics option.
vi. Select Accumulation Up to Current Time from the drop-down list.

vii. Click OK to accept the changes and dismiss the Properties Browser.

viii. Animate ( b ) the scenario and watch the grids highlight as they
meet the satisfaction criteria.

. Create a Number of Accesses Figure of Merit.

a. Attach a default Figure of Merit (r) to the Coverage Definition (%).
. . ﬁg . . ﬁ"
i. Inthe Insert STK Objects tool (@), select Figure of Merit (F% ).

5‘ Note: You may need to add the Figure of Merit object
to the Insert STK Objects tool. To do this, click the Edit
Preferences button and select it from the New Object
tool.

ii. Select Insert Default from the Select A Method list.

iii. Click the Insert... button.

iv. Select the Coverage Definition (&) object in the Select Object
dialog.

v. Click OK.

b. Right-click on the Figure of Meritin the Object Browser, and rename the
object (e.g. FOM_NumAccesses).

. Define the Figure of Merit.
i. Selectthe Basic - Definition page.
ii. Selectthe desired Figure of Merit Type (e.g. Number of Accesses).

iii. Selectthe desired Compute method (e.g. Total), if applicable
(depends on the Figure of Merit type).

iv. Click Apply to apply the changes and keep the Properties Browser
open.

d. Display the Static Graphics only.
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Vi.

Vil.

Select the 2D Graphics - Animation page.

. Disable the Show Animation Graphics option. By default, both

animation and static graphics are displayed.

iii. Selectthe 2D Graphics - Static page.

Enable the Show Contours option.

Click the Remove All button to remove the default levels in the Level
Attributes field.

Enter the desired Start, Stop, and Step levels.

o Start = Minimum FOM value in Grid Stats report.
o Stop = Maximum FOM value in Grid Stats report.
o Step=1.

Click OK to accept the changes and dismiss the Properties Browser.

e. Generate a Percent Satisfied report for the Figure of Merit (x).

iv.

Right-click on the Figure of Merit (r) in the Object Browser and
select Report & Graph Manager.

Disable the Show Graphs option located in the Styles field. You are
only interested in the reports so you can declutter the Styles window
by removing the graphs.

Expand (#) the Installed Styles directory and select Grid Stats.

Click Generate... to display the static Figure of Merit range.

f. Display Animation Graphics

Vi.
Vii.

viii.

Right-click the Coverage Definition (&) and select Properties (El).

. Select the 2D Graphics - Static page.

ii. Disable the Show Static Graphics option.

Select the 2D Graphics - Animation page.

Enable the Show Animation Graphics option.

Select Accumulation Up to Current Time from the drop-down list.
Enable the Show Contours option.

Click the Copy Static Levels button.

Click OK to accept the changes and dismiss the Properties Browser.

Animate ( b ) the scenario and watch the grids highlight as they
meet the satisfaction criteria.
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AGI Techs Say: The static behavior for a Figure of Merit specifies the value of quality over the
entire coverage period. Depending on the size of the coverage problem being analyzed, the
computation of the static values for each grid point can be time consuming. For this reason, the
static values are cached to allow for rapid generation of reports and modifications to graphical
representations once the static values have been computed. The computed static values will also

be saved and restored with the scenario if the SaveMode of the parent Coverage Definition object
is set to "Save accesses."

L

0 Warning: Don't forget to save your work!
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Part 12: Build a Volumetric Ob'!ect

Required Product Licenses: This training requires additional licenses to complete. You can
obtain the necessary license for the training by visiting http://licensing.agi.com/stk/evaluation or
calling AGI support.

Volumetrics

The Volumetric object is used to combine spatial calculations and volume grids that enable you to:

» Reportand graph calculations over time and across grid points
o Visually depict volumes representing various values interpolated across grid points

The spatial calculations and volume grids are defined using the Spatial Analysis tool in Analysis Workbench. This
tool allows you to create calculations and conditions that depend on locations in 3D space which are, in turn,
provided by user-defined volume grids.
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Task: Build an Area of Operations

1. Create a new scenario with the default start time and a one (1) second stop time.

a. Click the Create a new scenario (ﬁ) button.

b. Inthe New Scenario Wizard, set the following options:
o Enter a name for the scenario (e.g. STK_Volumetric).
o Leave the default analysis Start time and change the stop time to
one (1) second.

c. Click OK.
2. Enable Terrain for Analysis.

a. Enable Terrain for analysis if you have Terrain Server (requires Internet (
=

%))

i. Openthe scenario's (ﬁ) properties (EI).

i. Enable the Azimuth/Elevation mask option.

ii. Click OK.

b. Enable Terrain for analysis if you don't have Terrain Server.
i. Open the Globe Manager.
ii. Click the Add Terrain/Imagery button.

iii. Click the ellipsis button and browse to the location of the PDTT file.
(Typically, <STK Install
Folder>\AGN\STK11\Data\Resources\stktraining).

iv. Selectthe StHelens_Training.pdtt and click Open.

v. Click Yes when the warning pops up to Use Terrain for Analysis.

3. From the Insert STI§ Objects tool, select Area Target ) and select the Area
Target Wizard (@). This will define the Area of Operations.

a. Use the Insert Objects Tool to use an Area Target Wizard (@) to define an
Area Target ().

b. Setthe Area Type to Ellipse.

C. Setthe Semi-Major Axis and Semi-Minor Axis to 1500 km.

d. Setthe Latitude and Longitude of the Centroid (e.g. Latitude: 46.6 deg
Longitude: -122.3 deg).

e. Click OK.

4. Model a place object using the City Database and enable the terrain mask and
position above ground for the place.
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g.
h.

Search the City Database for Morton.

Insert Morton, Washington.

Open Morton's (Q ) properties (El).
Select the Basic - Position page and change the Height Above Ground to 20
ft.

g/i‘ Note: You are raising the height of the place above the terrain
to represent the height of the sensor.
Select the Basic - AzEIMask page.
Enable the Use: Terrain Data option.
Enable the Use Mask for Access Constraint option.

Click OK.

5. Build a complex conic sensor with a vertical field-of-view that will be used to
constrain the volumetric object.

a.

Insert a sensor attached to Morton.

Open the sensor's (@) properties (El) and select the Basic - Definition
page.

Set the Type to Complex Conic and set the Outer Half Angle to 180 deg.
Select the Constraints - Basic page.

Enable the Az-El Mask option.

Select the 2D Graphics - Projection page and enable the Use Constraints
option.

Select the AzEIMask option.

h. Select the 3D Graphics - Projection page and set the Space Projection to 50

km.

Click OK.

6. View the sensor field-of-view in the 3D Graphics window and see how the terrain is
affecting the sensor's field-of-view.
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Task: Create Components for the Volumetric Object.

1. Inserta Volumetric (&E) object using the Insert Default method.

2. Create a Spatial Component for the area target using Analysis Workbench that is
used to create a grid that visualizes the Volumetric object.

a. Create a Cartographic Grid Reference frame to constrain the area.

Vi.

Vil.

viii.

iX.

In the Object Browser, right-click on the Area Target ) and select
Analysis Workbench...

Select the Spatial Analysis tab.

iii. Click the Create New Volume Grid button.

Ensure the Type is set to Cartographic (default).

Enter a name for the volume grid (e.g. SmartCartographic) in the
Name field.

If the Parent object is not set to Area Target, click the Select... button
and choose the correct parent object.

Click the Set Grid Values button and set the Altitude options. (e.g.
Minimum 160 km, Maximum 2000 km, Number of Steps 20).

Click OK to save the volume grid properties and dismiss the Add
Spatial Analysis Component window.

Click OK to close Analysis Workbench.

b. Visualize the Simple Cartographic component.

Right-click Volumetric (&E) in the Object Browser.

Open Volumetric's properties (El).
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iii. Selectthe Basic - Definition page.
iv. Click the ellipsis button in the Volume Grid section.
V. Select Area Target from the Object List.

vi. Select SimpleCartographic as the Volume Grids for: Area Target
option.

vii. Click OK.

viii. View the Simple Cartographic grid in the 3D Graphics window.

3. Create a Volume Grid to constrain the cartographic reference frame to the sensor
field-of-view.

. Inthe Object Browser, right-click on the Area Target ) and select
Analysis Workbench...

Select the Spatial Analysis tab.

. Click the Create new Volume Grid button.

. Click the Select... button to choose Constrained as the Component Type.
. Click OK on the Component Type window.
Enter a name for the volume grid (e.g. SensorFOV) in the Name field.

If the Parent object is not set to Area Target, click the Select... button and
choose the correct parent object.

. Click the ellipsis button in the Reference Grid field.

Select Area Target as the Object and select Simple Cartographic as the
Volume Grids For: AreaTarget option.

j. Click the ellipsis button in the Spatial Condition field.

Select the Sensor as the Object and select Visibility as the Spatial Condition
For: Sensor.

. Click OK to save the volume grid properties and dismiss the Add Spatial
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Analysis Component window.
m. Click OK to close the Analysis Workbench.

4. View the volumetric object with the constrained grid.
a. Right-click Volumetric (&E) in the Object Browser.

b. Open Volumetric's properties (El).
C. Select the Basic - Definition page.

d. Click the ellipsis button in the Volume Grid field and select the Area Target
on the left and the constrained volume grid (e.g. SensorFOV) on the right.

e. Click OK.

f. Click the ellipsis button in the Spatial Calculation field and select the Area
Target on the left and the Altitude on the right.

g. Click OK.
h. Click Apply to apply the changes and keep the Properties Browser open.
5. Compute the Volumetric object.
6. Visualize the Volume Grid between 160 km and 2000 km.
a. Inthe Volumetric properties, select the 3D Graphics - Grid page.
b. Disable the Show Grid option.
C. Select the 3D Graphics - Volume page.
d. Enable the Spatial Calculation Levels option.
e. Clickthe Insert Evenly Spaced Values... button.
f. Insert evenly spaced values (e.g. Start: 160, Stop: 2000, Step: 200.
g. Click the Create Values button.
7. Display a legend.
a. Select the 3D Graphics - Legends page.
b. Enable the Show Legend option.
c. Click OK.

8. View the Spatial Calculation levels in the 3D Graphics window.
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9. Generate a Satisfaction Volume report to view the percent satisfied.

a. Right-click on the Volumetric object and open the Report & Graph
Manager.

b. Generate a Satisfaction Volume report.

ﬁ AGI Techs Say: There are several example scenarios using Volumetrics on our Support page.

Did You Know? Volumetrics can import user-supplied data such as weather? Check out this for
more information.

.
0 Warning: Don't forget to save your work!
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http://support.agi.com/

Part 13: Perform Trade Studies with Analxzer

Required Product Licenses: This training requires additional licenses to complete. You can

obtain the necessary license for the training by visiting http://licensing.agi.com/stk/evaluation or
calling AGI support.

STK Analyzer

The STK Analyzer ( L ) module is an integrated software solution that automates STK trade studies and parametric
analyses by blending the engineering analysis capabilities of Phoenix Integration, Inc.'s ModelCenter with STK.

Case Study
Phoenix Integration used AGl software to understand acquisition program costs
in the context of Department of Defense affordability mandate. You can read

more in this case study: Cost/Performance Trade Studies Improve DoD
Affordability Compliance.

Analyzer enables STK users to easily perform trade and optimization studies, as well as post-processing functions.
The Analyzer module provides the tools to understand the design space of your system through an easy-to-use

GUI style interface, eliminating the need for scripts or programming. STK Analyzer provides a set of analysis tools
that:

« Enable you to understand the design space of your systems.

« Enable you to perform analyses in STK easily without involving programming or scripting.
« Introduce trade study and post-processing capabilities.

Did You Know? Analyzer has its own toolbar! Just right-click in the toolbar area and enable the
Analyzer toolbar from the drop down. On the toolbar, you'll find buttons to open Analyzer, the
Parametric Study tool, and the ability to open previously generated trade studies.
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Task: Perform a Trade Study

1. Create a new scenario.

& &

o

Click the Create a Scenario (&) button.

In the New Scenario Wizard, set the following options:
i. Enter a Name for the scenario (e.g. STK_Analyzer).
ii. Define the analysis start and stop times or accept the defaults.

Click OK.

Insert a facility (ﬁ) (e.g. using the Insert Default method).

Insert a satellite (%) using the Define Properties method.

o Onthe Basic - Orbit page, adjust the Inclination to orbit over the
facility (e.g. 40 deg).

o Click OK to accept the default parameters and dismiss the Properties
Browser.

f. Inserta Sensor (@) on the Satellite (e.g. using the default method).

2. Generate an Access (n,) report.

Open the Access tool (n’!)l.

On the Access panel, click the Select Object... button and select the sensor
on the moving vehicle (e.g. satellite1-Sensor1) as the Access For object
("From").

Select the ground site as the "To" object (e.g. Facility).
In the Reports field, click the Access button. This will compute access, and

generate an Access report.

5/‘ Note: If your report says "No Access Found," modify your
vehicle properties so that the vehicle has access to the ground
site.

In the Timeline View toolbar, click the Add Time Components (@) button.

i. If your Timeline View is not open, extend the STK View menu
and select Timeline View.

Select the Access (4’9) object.

Select Accesslntervals in the Components for section.

h. Click OK to add the Access Intervals to the Timeline View and dismiss the

Add Time Components tool
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__—i‘ Note: In STK 11.3 Access Intervals are automatically added to
the Timeline. But if you are using an older version of STK, you
can add them manually to the Timeline.

3. Define Analyzer variables.

a. Extend the Analysis menu, extend the Analyzer menu, and select Analyzer (

o

).
b. Select one or more input variables.
i. Selectthe moving vehicle (e.g. Satellite1) in the STK Variables list.

ii. Click onthe variable (e.g. Propagator (TwoBody) in the STK
Property Variables General tab.

iii. Move or double-click the name to add it to the Analyzer Variables
field.

iv. Repeatthe previous step until all desired input variables are in the
Analyzer Variables field.

C. Select one or more output variables

i. Expand Access in the STK Variables list and select the moving
vehicle - sensor to ground site access.

ii. Expand the data provider (e.g. Access Data) in the Data Provider
variables tab.

iii. Selectthe desired variable (e.g. expand Duration and select sum)
and move or double-click the name to add it to the Analyzer
Variables field.

iv. Repeatthe previous step until all desired output variables are in the
Analyzer variables field.

4. Design a Parametric trade study.

a. Click the Parametric Study (To"_“:'_) button on the STK Analyzer window to open
the Parametric Study dialog.

b. Define the Design Variables.

i. Click and drag the desired input variables (e.g. SemiMajorAxis) in
the Components list and drop it in the design variable (“ ) box.

ii. Inthe Design Variable text fields, enter the desired values.
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c. Define the Responses.

i. Clickand drag the desired response variable (e.g. Access_Data
Duration sum) in the Components list and drop it in the Responses
section.

d. Click Run... to run the study and watch the 2D and 3D Graphics windows
and Timeline View change with each iteration.

5. Create a Carpet Plot trade study.

a. Click the Carpet Plot (%) button on the STK Analyzer window to open the
Carpet Plot tool dialog.

b. Define the Design Variables.

i. Clickand drag the desired input variables (e.g. SemiMajorAxis and
Inclination) in the Components list and drop itin the design

variable (7 )

ii. Inthe Design Variable text fields, enter the desired values.

(e.g:

Design Yariables
Hum
Name Fram To Steps Step Size

2 !ModelSTK.STK_AnaIyzer.SateIIite‘I.Propagalor.SemiMaiorAxis i88?8.14 FO7E.14 5 !50

+i iatellite‘l .Propagator. Inclination i30 B0 |4 |1 o

c. Define the Responses.

i. Clickand drag the desired response variable (e.g. Access_Data
Duration sum) in the Components listand drop it in the Responses
section.

d. Click Run... to run the study and watch the 2D and 3D Graphics windows
and Timeline View change with each iteration.

0 Warning: Don't forget to save your work!
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Part 14: Evaluate Communication Links

Required Product Licenses: This training requires additional licenses to complete. You can
obtain the necessary license for the training by visiting http://licensing.agi.com/stk/evaluation or
calling AGI support.

STK Communications

The Communications module allows you to define and analyze detailed communications systems. You can
incorporate detailed rain models, atmospheric losses, and RF interference sources in your analyses and generate
detailed link budget reports and graphs. Communications modeling in STK includes:

Case Study

There are two case studies that showcase the use of AGIl's Communications
module: NASA Space Communication Network Architecture Analysis andStudying
Mobile Ad-Hoc Network Communications Architectures.

» Modeling communications links under dynamic conditions.

o Performing communications link budget analysis.

« Presenting parameters, analysis, link behavior, and antenna patterns graphically in 2D, and when possible,
3D.

» Dynamically animating link parameter behavior.

« Determining an object's geometric or refractive/radio line-of-sight visibility.

» Performing system- level engineering.

These capabilities can be expanded upon by integrating Communications with commercially available network
modeling and simulation applications. Such integrations allow for communications analysis down to the protocol
layer to be fused into an entire mission construct modeled in STK. You can model and assess network-protocol-
level aspects such as:

« Buffering

« Routing

» Rate control

« Quality-of-service frameworks
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Task: Model Communication Equipment and Calculate Link Budget

1. Create a new scenario with the default time period.

a. Click the Create a new scenario (ﬁ) button.

b. Inthe New Scenario Wizard, set the following options:
o Enter a name for the scenario (e.g. STK_Comm).
o Define the analysis start and stop times or accept the defaults.

c. Click OK.
2. Incorporate terrain as a constraint.
a. Select the Basic - Terrain page.

b. Enable the Azimuth/Elevation Mask in the Advanced Analysis Operation
field.

C. Enable the Line-of-Sight, Terrain Mask, Azimuth-Elevation Mask, and
Coverage options.

d. Click OK.

3. Model a ground site (any type, Q : ﬁ @) that will model ground control
station.

a. Inserta Place (I:*-_h"I ) by typing in the location (e.g. Latitude = 46.28 deg;
Longitude = -122.22 deg).

b. Irls*e\rrt a Place (I:;:I ) using the Search by Address method (requires Internet

( %)) (e.g.Johnston Ridge, WA).

C. Ifusing a Place, openits Properties and select the 3D Graphics - Model
page.

d. Inthe Detail Thresholds field, move the slider for All to the right.
e. Select the Basic - AzEIMask page.
f. Set the following options:

e Use: Terrain Data
o Enable Use Mask for Access Constraint

g. Click OK.

4. Model a satellite (ﬁ)that has visibility to the ground site.

a. Inserta satellite using the Orbit Wizard method.
b. Ensure the orbit has at least one pass over the ground site.

5. Compute Access between the moving vehicle and ground site to assure access.
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&

f.

Open the Access (n’) tool.

Click the Select Object... button and select the moving vehicle as the
Access For object ("From").

Select the ground site as the "To" object.
Click the Compute button.
Click Access... in the Reports area to generate an Access report.

If there is no access, modify the moving vehicle's orbit, route, or trajectory.

]
6. Model a simple transmitter (@) on the satellite (%).

a.

(7]
Insert a Transmitter (@) on the satellite (ﬁ).

. . i -
i. Select Transmitter (@) in the Insert STK Objects (ﬂg) tool.
ii. Select Define Properties as the Select A Method option.

iii. Click Insert... to bring the Select Object window to the front.
iv. Select the satellite in the Select Object window.

v. Click OK. You will notice that the default transmitter is a simple
transmitter.

b. Change the transmitter's frequency (2 GHz) and EIRP (20 dBW).

i. Onthe Basic - Definition page, select the Model Specs tab.
ii. Enter the desired two (2) GHz Frequency value in the textbox.
iii. Enter the desired 20 dBW EIRP value in the textbox.

iv. Click OK to apply the changes and dismiss the Properties Browser.

7. Model a two (2) degree Simple Conic Sensor (@) on the ground site targeted
towards the satellite which acts as a pointing device for the ground antenna.

a. Insertasensor (@) on the ground site.

]
i. SelectSensor (@) in the Insert STK Objects (ﬁg) tool.
ii. Select Define Properties as the Select A Method option.

iii. Click Insert... to bring the Select Object window to the front.
iv. Selectthe ground site in the Select Object window.

V. Click OK.

b. Change the sensor's field-of-view to a two (2) degree Cone Half Angle.
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i. Selectthe Basic - Definition page.

ii. Enter the desired two (2) deg Cone Half Angle value in the text
field.

¢. Change the sensor's pointing to target the moving vehicle.
i. Select the Basic - Pointing page.

ii. Change the Pointing Type to Targeted in the drop-down list.

[
iii. Move () the satellite to the Available Targets list. You can also
double-click the satellite to move it to the Available Targets list.

d. Add an Azimuth and Elevation constraint to the sensor.
i. Selectthe Constraints - Basic page.
ii. Enable the AzEl Mask option.
AGI Techs Say: Sensors are used to point transmitters and receivers.
The easiest way to ensure that the transmitter and receiver
communicate with one another (in a geometric sense) is by attaching

them to sensors that point toward the objects they want to
communicate with.

¥
Model a complex receiver (ﬁ') with a parabolic antenna on the ground site's
sensor and display the volume graphics.

W
a. Inserta receiver (ﬁ') on the ground site's sensor.

i &
i. SelectReceiver (ﬁ') in the STK Insert Objects (ﬂg) tool.
ii. Select Define Properties as the Select A Method option.

iii. Click Insertto bring the Select Object window to the front.
iv. Select the sensor on the ground site in the Select Object window.
v. Click OK.
b. Change the receiver Type to Complex Receiver Model.
i. Selectthe Basic - Definition page.
ii. Click on the ellipsis (E) button beside the Type option.
iii. Selectthe Complex Receiver Model and click OK.

iv. Click Apply to accept the changes and keep the Properties Browser
open.

¢. Change the Antenna type to Parabolic with a 1.6 m diameter.
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i. Onthe Basic - Definition page, select the Antenna tab.
ii. Click on the ellipsis (E) button beside the Type option.
iii. Selectthe Parabolicand click OK.
iv. Enter the desired 1.6m Diameter in the textbox.

V. Click Apply to accept the changes and keep the Properties Browser
open.

d. Display the Volume Graphics.

i. Selectthe 3D Graphics - Attributes page.
ii. Enable the Show Volume option.
iii. Enter the desired 0.1 km Gain Scale (per dB) in the text field.

iv. Enable the Set azimuth and elevation resolution together
option.

v. Enter the desired one (1) deg resolution in the text field.

(73] 44
9. Compute Access (n”) from the transmitter (@) to the receiver (ﬁt).

Open the Access (n’) tool.

Click the Select Object... button and select the transmitter on the moving
vehicle as the Access For object ("From").

Select the receiver on the ground site's sensor as the "To" object.
Click Access... in the Reports area to generate an Access report.
Right-click on the first Start Time.

Extend the Start Time menu and select Set Animation Time.

Bring the 3D Graphics window to the front.

Click Step Forward (l b) in the Animation Toolbar a few times to allow the
volume graphics of the antenna pattern to exit terrain.

(7]
10. Generate atliink Budget report () between the transmitter (@) and the

receiver (ﬁ").

a.

Ensure the transmitter on the moving vehicle is selected as the Access For
object and the receiver on the ground site's sensor is set as the "To" object.

Click the Link Budget... button in the Reports area to generate a Link
Budget report.

Enter a smaller step size (e.g. 1 sec) in the Step text field. This updates the
report step size.
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d.

a.

b.

Locate the Bit Error Rate (BER) and determine the quality of the
communications link. (e.g. 1.000000e-10 or lower)

11. Create a new custom graph for your transmitter to receiver access that displays
the carrier to noise ratio (C/N).

Click the Report & Graph Manager... button in the Access tool.
In the Object Type drop-down list, select Access..

Select the transmitter to receiver Access object that will be the focus of the
graph.

Select the Scenario Styles directory and click the Create new graph style (

tlfﬂ) button.

Rename the graph CN and click Enter on the keyboard to bring up the
Graph Style properties.

Replace the asterisk (*) with C/N and click Filter.

Expand (#) the Link Information data provider.

h. Selectthe C/N data provider.

"
Move () the C/N data provider to the Y Axis.
Click OK to save the custom graph style.

Select the new graph style and click Generate....

Enter a smaller step size (e.g. 1 sec) in the Step text field. This updates the
graph step size.

Now that you have done communications from one moving vehicle (satellite), try it with other
moving vehicles like aircraft or ground vehicles.

0 Warning: Don't forget to save your work!
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Part 15: Analzze Radar sttems

Required Product Licenses: This training requires additional licenses to complete. You can
obtain the necessary license for the training by visiting http://licensing.agi.com/stk/evaluation or
calling AGI support.

STK Radar

The Radar module allows users to build radar system models, to simulate their performance in mission scenarios,
and to analyze their performance.

Case Study

Agilent combined two industry-leading electronic design automation (EDA) tools,
AGl's STK software and SystemVue from Agilent, to enable repeatable testing and
hundreds of "what if* scenarios. You can read more in this case study: Reducing
Flight Testing While Improving Effectiveness.

STK Radar also allows you to model an important characteristic of radar targets - radar cross section (RCS)- to
calculate and display access and to generate reports and graphs of radar system performance.

Radar simulates both monostatic and bistatic radar systems and supports operations in Synthetic Aperture Radar
(SAR) and/or Search/Track modes. Targets may be assigned multiple frequency-dependent radar cross sections
to coincide with the various bands in operation in the scenario.

Page 86 of 137



Task: Model a Radar and Measure The Quality

1. Create a new scenario.

a. Click the Create a new scenario (ﬁ) button.

b. Inthe New Scenario Wizard, set the following options:
o Enter a name for the scenario (e.g. STK_Radar).
o Define the analysis start and stop times so that the stop time is one
(1) week after the start time.

c. Click OK.

2. Update the Satellite Database.

a. Openthe scenario's (ﬁ) properties (El).

b. Select the Basic - Database page.

C. Click the Update Database Files... button.

d. Enable the Specific Database option.

e. Ensure the Database is set to stkAIITLE.

f. Click Update.

g. Click OK to close the information window.

h. Click Close to close the Update Satellite Database window.
3. Use Terrain Server for analysis.

a. Select the Basic - Terrain page.

b. Enable the Azimuth/Elevation Mask in the Advanced Analysis Operations
field.

C. Inthe Advanced Analysis Options, enable Line-of-Sight, Terrain Mask,
Azimuth-Elevation Mask, and Coverage.

d. Click OK.
4. Insert a facility that acts as a radar site.
a. Inserta facility using the Insert Default method.

b. Rename the facility (e.g. Radar_Site).

Open Radar_Site's (ﬁ) properties (El).

C

d. Inthe Basic - Position page, make the following changes:
o Latitude: 30.5 deg
» Longitude: -86.2 deg

e. Select the Basic - AzEIMask page.
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f. Make the following changes:
e Use: Terrain Data
o Enable Use Mask for Access Constraint

g. Click OK.
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Task: Use the Deck Access Tool to determine satellites in the radar's field-of-view.

1. Inserta sensor that mimics the radar system field-of-view.

a. Insertasensor (@) using the Insert Default method.

b.

(&

Attach a sensor (@) object to Radar_Site (ﬁ).

Rename the sensor (e.g. Radar_FOV).

Open Radar_FOV's (@) properties (El).

In the Basic - Definition page, make the following changes:

« Sensor Type: Rectangular
« Vertical Half Angle: 50 deg
« Horizontal Half Angle: 60 deg

Click Apply.

Select the Basic - Pointing page.

Make the following changes:

o Azimuth: 180 deg
o Elevation: 50 deg

Click Apply.

Select the Constraints - Basic page.

« SetRange - Max to 22000 nm.
o Enable the Az-El Mask option.

Click Apply.

L

E‘ Note: The system can track satellites 60 degrees on either side

—  of the sensor center line which provides 120 degrees of
azimuth coverage. The sensor has 100 degrees of vertical
coverage. The sensor points south (azimuth 180 degrees) and
an elevation of 50 degrees slants the sensor allowing for the
vertical coverage. Finally, the system is designed to track
satellites out to a distance of 22,000 nautical miles.

Select the 3D Graphics - Attributes page.

m. Set the Projection - % Translucency to 70.

n. Click OK.

2. Determine which satellites fly through the sensor's field-of-view.

a.

In the Object Browser, right-click on Radar_FOV and select Deck Access.

\

b. When the Deck Access Tool opens, set the Input - Stop to one (1) hour. This
samples the satellite database for one minute.
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c. Click the ellipsis button and select stkAllITLE.tce in the Select Target Deck
field.

d. Enable the Compute in Parallel option.

e. Click Compute Accesses.

4 )

E‘ Note: When the reportis completed, you can scroll through

— the report. Numerous satellites are seen for the full 3600
seconds time period. Most likely these are geosynchronous
satellites. Using Celestrak, you can search satellites by their
Name (NORAD Catalog Number). Disable filters to ensure you

geta hit.
\ y

f. When finished, close the report and the Deck Access tool.
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Task: Model the Target and the Radar.

1. Insert a satellite that has a large radar cross section (RCS).

i. Inserta Satellite using the From Standard Object Database method.

Insert a Satellite using the From Standard Object Database
method.

Enter 25544 (International Space Station) as the Name or ID.

iii. Click Search.

Select ISS (ZARYA).

Click Insert.

ii. Apply a realistic Radar Cross Section to the Satellite.

V.

Vi.

Open ISS_ZARYA _25544's (ﬁ) Properties (El).

. Select the RF - Radar Cross Section page.

Disable the Inherit option.
Set the Swerling Case to IV.

%/1‘ Note: Swerling Case IV probability density
function approximates an object with one large
scattering surface with several other small
scattering surfaces. The RCS varies from pulse
rather than from scan to scan.

Set the Constant RCS Value to 402 sqm.
Click OK.

2. Insertaradar thatis constrained to the sensor's field-of-view.

a. Insertaradar 9 using the Insert Default method.

b. Attach the Radar objecte to Radar_FOV (@)

C. Rename the Radar (e.g. ISS_Tracker).

d. OpenISS_Tracker's properties.

e. Select the Pulse Integration tab.

f. Change the Goal SNR to Fixed Pulse Number.

g. Setthe Pulse Number to eight (8).

h. Click Apply.
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p.
g.

Select the Antenna tab and set the following:
o Setthe Type to Phased Array.
« Inthe Spacing field, set Unit Type to Distance and set X to 0.374
meters. 0.374 meters is the antenna spacing based on the design
frequency of the antenna.

Click Apply.

Select the Beam Direction Provider tab and make the following changes:
o Enable the Beam Steering option.

[
e Move () ISS_ZARAYA 25544 to the Selected List.

Select the Transmitter tab and make the following changes:
o Setthe Wavelength to 68 cm.
o Setthe Power 370 kW. Each antenna element receives power from a
separate transmitter module having an output power of 10 kW.

Click Apply.

Select the Receiver tab.

Select the Additional Gains and Losses tab.

Click Add and set Gain to 25 dB. This simulates post processing gains.

Click Apply.

3. Constrain the Radar.

a.
b.

(&

Select the Constraints - Basic page.
Enable the Field-of-view and Az-El Mask options.

Click Apply.
o )
Ef Note: The Radar objectis a child of the sensor object, which is
a child of the Facility object. By enabling Field-of-view and Az-El
Mask, any reports or graphs using the Radar object will be
restricted to the Facility object's AzEIMask and the Sensor
object's field-of-view. This is a quick way to set access
constraints to the Radar object. However, if you require a more
realistic setup that might take interference into consideration,
this setup wouldn't be optimal since all access is restricted to

the sensor object's field-of-view.
\ y

4. Visualize the antenna pattern.

a.

b.

Select the 3D Graphics - Attributes page.
Enable the Show Volume option in the Volume Graphics field.
Enable the Show as Wireframe option.

Set the Gain Scale (per dB) to one (1) km.
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Set the Minimum Displayed Gain to negative -20 dB.
Enable the Set azimuth and elevation together option.
Set the Azimuth Resolution to 1 (one) deg.

Click OK.

Bring the 3D Graphics window to the front.

j. Zoom To to Radar_Site ﬁ

Zoom In or Out to view the antenna pattern.

Task: Track the International Space Station

1. Create a Probability of Detection Graph to determine when you can detect the ISS.

a.
b.

Right-click ISS_ZARAYA_ 25544 (ﬁ) and select Access (n’!).
Expand Radar_Site and then expand Radar_FOV.

Select ISS_Tracker (9).
Click the Report & Graph button.

Create a custom graph that shows the integrated probability of detection
and the probability of detection.

i. Right-click on the MyStyles directory.
ii. Extend the New menu and select Graph.
iii. Rename the graph PDET.
iv. Click Enter on the keyboard to open PDET's properties.

v. Expand the Data Provider called Radar SearchTrack.

[
vi. Move () S/T Integrated PDet to the Y-Axis.

[
vii. Move () S/T PDet1 to the Y2-Axis.
viii. Click OK.

ix. Generate the custom PDet graph.

AGI Techs Say: A search track value greater than 50% is acceptable
for probability of detection (S/T PDet1 = 0.50).
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Task: How will changing the antenna element configuration affect your analysis?

There are a few things that may positively or negatively affect the system. Adjusting the
antenna may improve calculated data, but could result in false positive results.

1. Change the antenna element spacing distance.

a. OpenISS_Tracker's (9) properties (El).
b. Selectthe Antenna tab.

c. Setthe Unit Type to Distance and set X to 0.68 m in the Spacing field. This
action will place each array further apart, essentially increasing the beam
width of the system.

d. Click Apply.
e. Examine the PDet graph data. PDet maximum values should increase.

f. Setthe scenario time to a moment of Access and examine the 3D Graphics
window.

g. Decrease the Time Step to 0.1 sec and animate the scenario.

The back lobes of the array will appear when the satellite is closer to the
horizon. This occurs because the beam began to point beyond its field-of-view
threshold. Therefore, while the total PDet may have increased, the system is in
fact providing false positive data.

\

2% Note: In this situation, the element spacing was increased

— beyond the ideal level. You can read up on this behavior on our
FAQ page (http://agiweb.force.web.com/faqgs/articles/What-
can-happen-if-inappropriate-element-spacing-is-introduced-
in-a-phased-array-antenna). This behavior is common when an
array exceeds the designed specifications. With the 3D
Graphics display, you can verify the behavior by examining the

system virtually or by having more information on your target.
\ y

h. Bring ISS_Tracker's (9) properties (El) to the front.
i. Reset the Distance spacing to .374 m.

j. Click OK.

k. Return to the 3D Graphics window and animate the scenario. The array and
back lobes have returned to normal.

0 Warning: Don't forget to save your work!
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Part 16: Integ rating STK with MATLAB
Integrating STK and MATLAB

The STK Integration module allows you to control STK from an external application, such as MATLAB. There are
several options for how to integrate STK and MATLAB, although the most common method is using Microsoft
COM. Using the COM interface, MATLAB users can connect to STK's Object model and Connect interfaces.

AGI Techs Say: The Object Model can easily be explored using the .get and .invoke commands
from the MATLAB prompt. Additionally, there are code snippets in the STK Help for the STK Object
Model.

Did You Know? There are several MATLAB code samples installed with STK. They can be found in
C:\Program Files\AGN\STK 11\CodeSamples\Automation.

ﬁ AGI Techs Say: The STK Programming Interface help system has several code snippets to assist
you

AGI Techs Say: A recorded PowerPoint presentation (https://p.widencdn.net/ysl41m/Part16_
Integration_JB) and MATLAB script (install directory\Data\Resources\stktraining\scripts)
accompanies this lesson. It is recommended that you follow the presentation while performing the
tasks. If you don't want to use the MATLAB Script, you can type the commands right in the

MATLAB Command Window.
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Task: Create a New Instance of STK from Inside MATLAB

Let's use MATLAB to create a new instance of STK.

—_

Launch MATLAB.

2. Select the Home tab.

3. Click the Open button.

4. Browse to the location of the saved script file.
5. Open the STK_MATLAB_Script.m file.

MATLAB is up and running. You can use the MATLAB script file to build a simple STK scenario
from which you will extract data into MATLAB.

When connected to STK via MATLAB, while creating your variable, using the Tab key after
periods enables Intellisense, which displays all of the options available off of the current
object. Try it. Create a new instance of STK11 in MATLAB.

1. In MATLAB, type the following code into the Command window:

app = actxserver('STK1l.application')
app.UserControl = 1

2. Grab a handle on the STK application root.

root = app.Personality2

Task: Create a New STK Scenario from Inside MATLAB

Now that you have launched STK via the MATLAB interface, let's see if we can create a new
scenario, set the time period via MATLAB, and reset the animation time.

1. In MATLAB, place your cursor to the left of the percentage sign for Task 2.
2. Select CTRL + Enter to run all of the MATLAB code in Task 2.
%Task 2
3. Create a new scenario:
scenario = root.Children.New('eScenario', 'Matlab_Starter')
4. Setthe analytical time period:
scenario.SetTimePeriod('Today", '+24hr")
5. Reset the Animation Time:
root.ExecuteCommand('Animate * Reset')

6. Click onyour STK scenario and see the name of the scenario, scenario analysis
period, and the animation time have been updated.
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Task: Insert and Configure Objects

With a new scenario created, it's time to populate the scenario with objects. Take a moment
to create a target and a LEO satellite using MATLAB.

1.
2.

In MATLAB, place your cursor to the left of the percentage sign for Task 3.
Select CTRL + Enter to run all of the MATLAB code in Task 3.

%%
%Task 3

Add a target object to the scenario.
target = scenario.Children.New('eTarget', 'GroundTarget');
Move the Target object to a desired location.
target.Position.AssignGeodetic(50,-100,0)
Add a satellite and configure its properties.
satellite = scenario.Children.New('eSatellite', 'LeoSat')
Propagate the satellite object's orbit.

root.ExecuteCommand([ 'SetState */Satellite/LeoSat Classical
TwoBody "',scenario.StartTime, ,scenario.StopTime,"'" 60 ICRF
"',scenario.StartTime,'" 7200000.0 0.0 90 0.0 0.0 0.0'])

Click on the STK scenario and look at the added Ground Target at)50, -100) and
the Propagated LeoSat.
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Task: Compute Access Between Objects

You have a scenario with a target object and a satellite object. You can determine when the
satellite object can access the target object.

1.
2.

Browse to the The STK's Programming Interface help files.

Locate and manually enter code into MATLAB to compute an access between two
STK Objects using the IAgStkObject interface. The access is between the satellite
object and the target object.

a. The location of the required code snippets is STK Programming Interface -
> Using Core Libraries -> STK Object Model -> MATLAB Code Snippets.

b. Locate the Compute an access between two STK Objects (using
IAgStkObject interface) page.

c. Type the following code

access = satellite.GetAccessToObject(target)
access.ComputeAccess

d. Bring the STK scenario to the front and look for the access ground tracks in
the 2D Graphics window.

Retrieve access interval start/stop times.
In MATLAB, place your cursor to the left of the percentage sign for Task 4.
Select CTRL + Enter to run all of the MATLAB code in Task 4.

accessDP = access.DataProviders.Item('Access Data').Exec
(scenario.StartTime,scenario.StopTime);

accessStartTimes = accessDP.DataSets.GetDataSetByName('Start
Time').GetValues

accessStopTimes = accessDP.DataSets.GetDataSetByName('Stop
Time').GetValues

Scroll through the MATLAB Command Window to see the access start and stop
times.
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Task: Retrieve Satellite Altitude During Access
1. Retrieve and view the altitude of the satellite during an access interval.
2. In MATLAB, place your cursor to the left of the percentage sign for Task 5.

3. Select CTRL + Enter to run all of the MATLAB code in Task 5.

%%
%Task 5

satelliteDP = satellite.DataProviders.Item('LLA
State').Group.Item('Fixed').ExecElements(accessStartTimes
{1},accessStopTimes{1},60,{ 'Time'; 'Alt'});
satellitealtitude = satelliteDP.DataSets.GetDataSetByName
('Alt').GetValues

4. Scroll through the MATLAB Command Window to see the altitude data output.

0 Warning: Don't forget to save your work!

For additional MATLAB training with STK, refer to Using MATLAB for STK Automation (PDF).
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Part 16: Integ rating STK with Pzthon

AGI Techs Say: Arecorded PowerPoint presentation (https://p.widencdn.net/ysl41m/Part16_
Integration_JB) and Python script (install directory\Data\Resources\stktraining\scripts)
accompanies this lesson. It is recommended that you follow the presentation while performing the
tasks. If you don't want to use the Python Script, you can type the commands right in the Python
Command Window.

Integrating STK and Python

AGI Techs Say: The has several code snippets to assist you. Visit our FAQ site to learn more about
. Additional Python Resources are on GithubGithub (https://github.com/agifsnyder/STK-
Integration/blob/master/STK and Python with comtypes.ipynb).
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Task: Create a New Instance of STK from Inside Python

This lesson utilizes Python 3.5. Before starting this lesson verify that you have a working
Python environment. In this example, Spyder and Anaconda are used. You may also use your
preferred python environment (i.e. WinPython and Juypter or others).

1. Launch Spyder (or your preferred method)
2. Select the Home tab.

3. Click the Openicon.
4

Browse to the script file located at Install
Directory\Data\Resources\stktraining\scripts.

5. Inthe Current Folder field, double click the file named STK_PYTHON_Script.py.

Python is up and running. You will use the Python script file to automate building a simple STK
scenario from which you will extract data into Python.

If you are building your script from scratch, use the following commands:
1. Set up your Python workspace
from win32api import GetSystemMetrics
2. Now importthe Com Types
from comtypes.client import CreateObject

When connected to STK via Python, while creating your variable, using the Tab key after
periods enables IntelliSense which displays all of the options available off of the current
interface. Try it.

—_

. Create a new instance of STK11.

2. In Python, type the following code into the Command window:
uiApplication=CreateObject("STK11l.Application")

3. Click Enter.

uiApplication.Visible=True
uiApplication.UserControl=True

4. Click Enter.
5. Grab a handle on the STK application root.
6. In Python, type the following code into the Command window and then click Enter.
root = uiApplication.Personality2
7. Click Enter.
E/‘ Note: When 'root=uiApplication.Personality2' is executed, the
comtypes library automatically creates a gen folder that contains

STKUtil and STK Objects. After running this at least once on your
computer, the following two lines should be moved before the
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E} ‘uiApplication=CreateObject("STK11.Application")’
from comtypes.gen import STKULi

from comtypes.gen import STKObjects

Task: Create a New STK Scenario from Inside Python

Now that you have launched STK via the Python interface, let's see if we can create a new
scenario and set the time period via Python.

1. Create a new scenario, analysis period and reset the animation time.

2. In Python, copy and paste all the code from the Editor window (to included
comments (#)) from Task 2 and paste it to the Command Window.

##

#TASK 2

# 1. Create a new scenario.
root.NewScenario("Python_Starter")

scenario = root.CurrentScenario

# 2. Set the analytical time period.

scenario2 = scenario.QueryInterface(STKObjects.IAgScenario)
scenario2.SetTimePeriod('Today', '+24hr")

# 3. Reset the animation time.

root.Rewind();

3. Click Enter.
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Task: Insert and Configure Objects

With a new scenario created, it's time to populate the scenario with objects. Take a moment
to create a facility and a LEO satellite using Python.

1. Insert Target and Satellite objects into the scenario.

2. In Python, copy and paste all the code from the Editor window (to included
comments (#)) from Task 3 and paste it to the Command Window.

#H#
#TASK 3
#1. Add a target object to the scenario.

target = scenario.Children.New
(STKObjects.eTarget, "GroundTarget");

target2 = target.QueryInterface(STKObjects.IAgTarget)
#2. Move the Target object to a desired location.
target2.Position.AssignGeodetic(50,-100,0)

#3. Add a Satellite object to the scenario.

satellite = scenario.Children.New(STKObjects.eSatellite,
"LeoSat")

#4. Propagate the Satellite object's orbit.
root.ExecuteCommand( 'SetState */Satellite/LeoSat Classical

TwoBody "' + scenario2.StartTime + '" "'+ scenario2.StopTime +'"
60 ICRF "'+ scenario2.StartTime + '" 7200000.0 0.0 90 0.0 0.0
0.0")

3. Click Enter.

g/" Note: The SetState Classical Connect command and syntax can be found
— here.
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Task: Compute Access Between Objects and Retrieve Data From STK

You now have a scenario with a Target object and a Satellite object. Determine when the
Satellite object can access the Target object

1. Browse to the STK Programming Interface help files.

2. Locate and manually enter code into Python to compute an access between two
STK Objects using the IAgStkObject interface. The access is between the Satellite
object and the Target object.

3. If you cannot locate the code, expand the following

a. The location of the required code snippets is STK Programming Interface >
Using Core Libraries > STK Object Model > Python Code Snippets. Locate
STK Objects > Access. The required snippet is Compute an access between
two STK Objects (using I1AgStkObject interface).

access = satellite.GetAccessToObject(target)

access.ComputeAccess()
b. Retrieve and view the access data in Python.

C. InPython, copy and paste all the code from the Editor window (to included
comments (#)) from Task 4 and paste it to the Command Window.

accessDP = access.DataProviders.Item('Access Data')

accessDP2 = accessDP.QueryInterface
(STKObjects.IAgDataPrvInterval)

results = accessDP2.Exec(scenario2.StartTime,
scenario2.StopTime)

accessStartTimes = results.DataSets.GetDataSetByName( 'Start
Time').GetValues()

accessStopTimes = results.DataSets.GetDataSetByName('Stop
Time').GetValues()

print(accessStartTimes,accessStopTimes)

4. Click Enter.
Task: Compute Access Between Objects and Retrieve Data From STK

1. Retrieve and view the altitude of the satellite during an access interval.

2. In Python, copy and paste all the code from the Editor window (to included
comments (#)) from Task 5 and paste it to the Command Window.

satelliteDP = satellite.DataProviders.Item('LLA State')

satelliteDP2 = satelliteDP.QueryInterface
(STKObjects.IAgDataProviderGroup)

satelliteDP3

satelliteDP2.Group.Item('Fixed")
satelliteDP4

satelliteDP3.QueryInterface
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(STKObjects.IAgDataPrvTimeVar)
rptElements = ['Time', 'Lat', 'Lon', 'Alt']

satellitDPTimeVar = satelliteDP4.ExecElements
(accessStartTimes,accessStopTimes, 60, rptElements)

satelliteAltitude = satellitDPTimeVar.DataSets.GetDataSetByName
('Alt'").GetValues()

print(satelliteAltitude)

3. Click Enter.

0 Warning: Don't forget to save your work!
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Part 16: Integ rating STK with Excel

In this lesson you will utilize the Excel Developer Tab. If the Developer Tab does notappear in your Menu Ribbon,
then please follow the steps on the Microsoft Help site to enable the feature.
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Task: Create an Excel Spreadsheet to Use with STK

1. Launch Excel and create a new Spreadsheet (if not already open), save your excel
file as a .xIsm file.

2. Select the Developer tab. If you do not see the Developer tab, right-click on the
toolbar above the spreadsheet > “Customize the Ribbon ..." and check the
Developer box

Excel Options =
Genenal
q_’ ‘Customize the Ribbon.
Fearmulas
e Choose comenands froer: Custornize the Riben:
wooting Popular Cemmands =] Main Tabs =]
Save
(4l AN Chart Types... =] [Miain Tabs
Langusge " Bosdens v  [¥] Home
Advanced B Calkulste Now B [ Insent
Center 5 4] Page Layout
Customize Risben El Corditional Formatting k B [ Formules
& - 2! Connections "
Quick Aceess Toolbar D Copy & [7] Data
Add-Ins [ Custorn Sort.. L B [¥] Review
X Cut = B [7] View
Trust Center & Decrease Fort Size [[= WDeveloper |
e
% Delete Cel... e
#  Delete Sheet Columpn B AddeTns =
2% Delete Sheet Rows B -
9 Emel ¥ Controls
: ® 0L -
D Fill Color B =4t
Y 5 ] B Medify
iter ® [ Add-lns
Font = =

3. Click the Inserticon and add a Form Controls-Button.
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ﬁ-} E ﬂ L\/ [E] Properties
Insert [-

ol View Code
Add-Ins  COM N

Add-Ins - -,. -. ,:.. E Run Dialog

Add-Inz Controks
; JElGEL
x ;P W =
o E Button (Form Control) H
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4. When assigning a Macro name, use LaunchSTK, then click New. If you missed the
new part, you can right-click on the button > Assign Macro, double-check the
name and click New.

| Assign Macro - - x ,‘

Macro name:
LaunchsTH 5.5 [ Mew ]

5. Rename the button to "Launch STK"
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Task: Create an STK Instance from Excel

You will use the Excel script file to build a simple STK scenario from which you will extract data
into Excel. You can use VB script or object model and for automation you can use your
preferred method, connect will be demonstrated in this example.

Create a new instance of STK11.

1. In the module window of the Visual Basic editor, type the following code before
Sub LaunchSTK(). This creates the global variables.

Dim app
Dim root
Dim scenario

2. Type the following code within Sub LaunchSTK() to create a new instance of STK

‘create new instance of STK

Set app = CreateObject("STK.Application")

' connect to an already running instance of STK
' Set app = GetObject(, "STK.Application")
app.Visible = True

' Grab a handle on the STK application root

Set root = app.Personality2

3. Testthis Sub. You canrun it by either pushing the "Launch STK" button or by
selecting the Sub and clicking the green Run button

Task: Create a New STK Scenario from Inside Excel

Now that you have launched STK via the Excel interface, let's see if we can create a new
scenario and set the time period via Excel.

1. Create a new button called "Create Scenario" that calls a macro names
CreateScenario.

2. InExcel, copy and paste all the code from the Editor window (to included
comments (*)) from Task 2 and paste it into Sub CreateScenario().

' TASK 2

' Create a new scenario.
root.NewScenario("ExcelWebinar™)

Set scenario = root.CurrentScenario

¢ Set the analytical time period.

notUsed = scenario.SetTimePeriod("Today", "+24hr")
' Reset the animation time.

notUsed = root.Rewind()

3. Run this new Sub.
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Task: Insert and Configure Objects

With a new scenario created, it's time to populate the scenario with objects. Let's create a
number of Target objects and a satellite from Excel.

1. Insert Target objects names, and random latitudes and longitude into Excel. | will
be using column F for the target name, column G for the latitude and column H for
longitude.

Add column headers for

o TargetName
o Latitude
o Longitude

2. Add the values. The name will be simply Target1 while latitude and longitude will
be a random location between -90 —90 and -180 — 180 respectively

F G H
Target Mame Latitude Longitude
Targetl =(RAND() - 0.5)*180  =(RAND{) - 0.5)*360

3. Select the three lower cells and pull them down until we have 25 targets.

4. Create a new button called “Insert Targets” that calls a marco names
InsertTargets.

5. InExcel, copy and paste all the code from the Editor window (to included
comments (*)) from Task 3.a and paste it into Sub InsertTargets().

' TASK 3.a
' Add a target object to the scenario.
For i = 2 to 26

Dim target

Set target = root.CurrentScenario.Children.New(23, Range("F" &
i).value)

' Move the Target object to a desired location.

notUsed = target.Position.AssignGeodetic(Range("G" & i).Value,
Range("H" & i).Value, 0.0)
Next

6. Create a new button called "Insert Satellite" that calls a macro names InsertSatellite

7. In Excel, copy and paste all the code from the Editor window (to included
comments (")) from Task 3.b and paste it into Sub InsertSatellite().

' TASK 3.b

' Add a Satellite object to the scenario.

Dim satellite

Set satellite = root.CurrentScenario.Children.New(18, "LeoSat")
' Propagate the Satellite object's orbit.

root.ExecuteCommand ("SetState */Satellite/LeoSat Classical
TwoBody UseScenarioInterval 60 ICRF ""UseAnalysisStartTime""
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7200000.0 0.0 90 0.0 0.0 0.0")

8. Run this Sub

B‘ Note: The SetState Classical Connect command and syntax can be
found here.
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Task: Compute Access Between Objects and Retrieve Data From STK

You now have a scenario with a Target object and a Satellite object. Determine when the
Satellite object can access the first Target object.

1. Create a new button called “Compute Access” that calls a marco named
ComputeAccess.

2. InExcel, copy and paste all the code from the Editor window (to included
comments (")) from Task 4.a and paste itinto Sub ComputeAccess().

' Task 4.a

' Compute Access between the satellite and the target
Dim sat

Set sat = root.GetObjectFromPath("Satellite/LeoSat")
Dim tarl

Set tarl = root.GetObjectFromPath("Target/Targetl")
Dim access

Set access = sat.GetAccessToObject(tarl)

'Compute access

access2 = access.ComputeAccess()

3. Let's now retrieve and view the access data in Excel.

4. In Excel, copy and paste all the code from the Editor window (to included
comments (")) from Task 4.b and paste it into the bottom of Sub ComputeAccess().

' Task 4.b

¢ Pull the data of interest out of the access object

Dim dp

Set dp = access.DataProviders("Access Data")

Dim results

Set results = dp.Exec(scenario.StartTime, scenario.StopTime)
accessNumber = results.DataSets(0).GetValues()

accessStart = results.DataSets(1).GetValues()

accessStop = results.DataSets(2).GetValues()

accessDuration = results.DataSets(3).GetValues()

¢ Write column header

Range("J1") = results.DataSets(0).ElementName
Range("K1") = results.DataSets(1).ElementName
Range("L1") = results.DataSets(2).ElementName
Range("M1") = results.DataSets(3).ElementName

¢ Write the data into Excel.
For i = @ To UBound(accessNumber)

Range("J" & i + 2) = accessNumber(i)
Range("K" & i + 2) = accessStart(i)
Range("L" & i + 2) = accessStop(i)
Range("M" & i + 2) = accessDuration(i)
Next

5. Run this new Sub
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6. We need to format the access start and stop time correctly. Select the cell
containing the start and stop times, right-click on the selection, open the Format
Cells option and set the format to dd mmm yyyy hh:mm:ss.000. Alternatively, this
can be done through the script with

ActiveSheet.Columns("K").Select
Selection.NumberFormat = "dd mmm yyyy hh:mm:ss.000"
ActiveSheet.Columns("L").Select
Selection.NumberFormat = "dd mmm yyyy hh:mm:ss.000"

Task: Compute Access Between Objects and Retrieve Data From STK

Create a new button called "Report Satellite LLA" that calls a marco named ReportSatelliteLLA.
Retrieve and view the altitude of the satellite during an access interval.

1. In Excel, copy and paste all the code from the Editor window (to included
comments (') from Task 5 and paste it into Sub ReportSatelliteLLA().

' Task 5

' Take the satellite data and bring it into Excel
Dim 1la
Set 1la = root.ExecuteCommand("Report RM */Satellite/LeoSat
Style ""Installed Styles/LLA Position""")

' Read the data into Excel.

Report_RM places a blank line at the end of the report, use
Count - 2

For i = @ To 1la.Count - 2

Dim thisLineSplit

thisLineSplit = Split(lla(i), ","

Range("M" & i + 1) = thisLineSplit(0)
Range("N" & i + 1) = thisLineSplit(1)
Range("0" & i + 1) = thisLineSplit(2)
Range("P" & i + 1) = thisLineSplit(3)

Next

2. Click Enter.
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Task: Use the Excel Add In to Pull Data from STK

If you want to simply pull data from STK into Excel or pass certain data types from Excel into
STK, the Excel add-in may already do what you want you need. You can get the install from the
Software Downloads area on the AGl.com support page. (https:/support.agi.com/)

1.

Once the add-inis installed, enable it in Excel.
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Code Controls
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Currency Tools
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Click the first button to either start a new instance of STK or connect to an already

running one.

Select the base cell you want the data to be loaded from STK into Excel.

Click the Import button in the Add-in.

Select the Data Provider you want to add.
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StartTme: | 19May 201704:00:00.

SopTme: | ZMay mrm;m.m\

sepped: | @

Select a spreadsheet cell to be the top-left cell of
the report, and then dick the Gererate bution.

7. Click the Generate button.

Time

$246.367

19 May 2017 04:01:00.000000000
19 May 2017 04:02:00.000000000
15 May 2017 04:03:00.000000000
19 May 2017 04:04:00.000000000
13 May 2017 04:05:00.000000000
15 May 2017 04:06:00,000000000
15 May 2017 04:07:00.000000000
19 May 2017 04:08:00.000000000
19 May 2017 04:09:00.000000000
19 May 2017 04:10:00.000000000
19 May 2017 04:11:00.000000000
19 May 2017 04:12:00.000000000
19 May 2017 04:13:00.000000000
15 May 2017 04:14:00.000000000
19 May 2017 04:15:00.000000000
19 May 2017 04:16:00.000000000
15 May 2017 04:17:00.000000000
19 May 2017 04:18:00.000000000
19 May 2017 04:19:00,000000000
15 May 2017 04:20:00,00000000¢
15 May 2017 04;21:00.000000000
19 May 2017 04:22:00.000000000
19 May 2017 04:23:00,000000000
19 May 2017 04:24:00,000000000
19 May 2017 04:25:00,000000000
19 May 2017 04:26:00.000000000
13 May 2017 04:27:00,000000000

3267.806
3276.403
3271909
3254.133
3222.934
78231
3119.998
3048.266
2963.128
2864.734
2733.291

2629.07
2492396
2343.653
2183.282
2011751
1829.699

1637.64
1436.257
1226.251

1008.37
TE3.4025
5521791

7446474
-170.196
-417.458

¥

6426582
6399333
6347.452
6271354

617133

604792
5801714
5733.389
5543.707
5333511
5103.722
4855.333
A589.408
4307.073.
4009.516
3637.979
3373752

3038.17
2692.606
2338467
1977.185
1610.214
1239.023
865.0893
4898945
114.9164
-258.376
628,528

7193,

0 Warning: Don't forget to save your work!
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Part 17: Model Aircraft Missions with Aviator

Required Product Licenses: This training requires additional licenses to complete. You can
obtain the necessary license for the training by visiting http://licensing.agi.com/stk/evaluation or
calling AGI support.

Lesson 17.1: Aviator

Aviator provides an enhanced method for modeling aircraft - more accurate and more flexible than the standard
Great Arc propagator.

«Q Case Study

The U.S. Marine Corps used AGl's software as a pre-mission planning tool to
optimize expensive combat assets (UAVs, planes) and protect warfighters in
Afghanistan's physically challenging terrain. You can read more in this case study:
U.S. Marine Corps Combat Development Command Fields STK-Base UAS Tool in
Afghanistan.

With Aviator, the aircraft's route is modeled by a sequence of curves parameterized by well known performance
characteristics of aircraft, including cruise airspeed, climb rate, roll rate, and bank angle. The precise state of an
aircraft at any given time can be computed analytically - swiftly and without excessive data storage needs.

An aircraft using Aviator is defined by the type of aircraft and by the mission it performs. This structure allows you
to utilize an aircraft for much more than simple linear travel.
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Task: Create a New Aviator Scenario, Model a Runway, Location to Fly Over, and an
Aircraft with the Aviator Propagator

1. Create a new scenario with the default time period.

a. Click the Create a new scenario (ﬁ) button.

b. Inthe New Scenario Wizard, set the following options:
« Enter a name for the scenario (e.g. STK_Aviator).
« Define the analysis start and stop times or accept the defaults.

¢. Click OK.

2. Add Analytical Terrain to the scenario.
a. Open Globe Manager (&).

b. Click the Add Terrain/Imagery (ﬂ) button and browse to the terrain data
file (e.g. PtMugu_Chinalake.pdtt).

a. The example file is located at <STK Install
Folder>\Data\Resources\stktraining\samples\SeaRangeResou
rces

r UUUU
Ef Note: Depending on the desired terrain file, you may need

to change the file type when browsing.
\

g/i‘ Note: The STK Install folder is different depending on what
version of STK you have installed. The STK 64 bit version
install folder is C:\Program Files\AGN\STK 11.

\

C. Click OK to apply changes and dismiss the Properties Browser.
3. Load ARINC424 Runways using the Aviator Catalog Manager.
a. Open the Utilities menu and select Aviator Catalog Manager.
b. Expand Runways and select ARINC424 Runways.
c. Enable the Use Master Data File and click the ellipsis () button.
d. Browse to <STK Install Folder>\Data\Resources\stktraining\samples.
e. Select FAANFD18 and click Open.
f. Inthe Aviator Catalog Manager, click Save.

g. Close the Aviator Catalog Manager.

4. Inserta Ship (i) object using the Define Properties (El) method.
a. Change the Altitude Reference to MSL.

b. Change the Route Calculation Method to Specify Time.
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C. Click Insert Point.

d. Setthe Latitude to 33.5 deg.

e. Setthe Longitude to -120 deg.

f. Click Insert Point.

g. Add three (3) hours to the Time and Click OK. The ship's location will be
used as one of the aircraft's waypoints. We need to make sure that the ship
exists during the aircraft's entire flight.

5. Model anaircraft with the Aviator Propagator.

a. Insertan aircraft using the From Standard Object Database method.

b. Type Hornetin the Name field and click Search.

C. Select FA-18C_Hornet and click Insert.

d. Close the Search Standard Object Database.

6. Define an aircraft route using the Aviator Propagator.

a. OpenFA-18C_Hornet's (ﬂ) Properties (EI).

b. Right-click on Phase 1 and select Insert First Procedure for Phase (ﬁ)

button.

C. Inthe Select Site Type field, select Runway from Catalog.

Vi.

Vil.

In the Filter field, type mugu and click the Enter key on your
keyboard.

Select POINT MUGU NAS (NAVAL BASE VEN 03 21) and click Next.

ii. Select Takeoff in the the Select Procedure Type field.

Set the Runway Altitude Offset to seven (7) feet.
Enable the Use Terrain for Runway Altitude option.
Click Finish.

Click Apply.

d. When the Flight Path Warning appears, set the Optimize for STK Aviator
and click OK.

e. Right-click on the Takeoff procedure and select Insert Procedure After (ﬁ).

i. Select STK Object Waypoint and link to Ship1 (i).

Set the Offset Mode to Bearing/Range (relative to North).

Set the Range to ten (10) nm.
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Vi.
Vii.
viii.
iX.
X.
Xi.

Xii.

Click Next.

Select Enroute (f:").

Set the name to Fly 10 nm from Ship.

Disable the Use Aircraft Default Cruise Altitude.
Set the MSL Altitude to 15000 ft.

Set the Nav Mode to Arrive on Course.

Set the Arrive on Course option to 180 deg (True).
Click Finish.

Click Apply.

Right-click on the Fly 10 nm from Ship procedure and select Insert
Procedure After.

Vi.

Vii.

Select the End of Previous Procedure option.
Click Next.

Select the Basic Maneuver page and set the name to Straight to 2
nm.

Ensure the Strategy is set to Straight Ahead and enable the
Downrange stop condition.

Set the Downrange stop condition to two (2) nm.
Click Finish.

Click Apply.

Right-click on the Straight 2 nm procedure and select Insert Procedure

After.

Vi.

Vii.

Select the End of Previous Procedure (P‘) option.

. Click Next.

iii. Selectthe Basic Maneuver option and set the Name to Weave.

Set the Strategy to Weave and enable the Downrange Stop
Condition.

Set the Downrange Stop Condition to one (1) nm.
Click Finish twice.

Click Apply.

Right-click on the Weave procedure and select Insert Procedure After.
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Vi.

Vii.

Select the End of Previous Procedure (P‘) option.

. Click Next.

iii. SelectBasic Maneuver and set the Name to Loop.

Set the Strategy option to Loop.

In the Load Factor option, set the Bottom of Loop option to five (5)
G-Sealevel.

Click Finish.

Click Apply.

i. Right-click on the Loop procedure and select Insert Procedure After.

i.
il.
iii.
iv.
V.

Vi.

Select the End of Previous Procedure (P‘) option.
Click Next.

Select Basic Maneuver and set the Name to Left Turn.
Set the Strategy option to Simple Turn.

Click Finish.

Click Apply.

J- Multi-select the Weave and Loop procedures.

k. Right-click on the two procedures and extend the Copy, Paste, Edit menu.

l. Select the Copy Procedures option.

m. Right-click on the Turn Left procedure and select Insert Procedure After.

V.

Vi.

Select the Super Procedure (& option.
Set the Name to Repeat Maneuvers.

Click Next.

Click the Load Procedures from Clipboard button. You will notice the
two procedures are added.

Click Finish.

Click Apply.

n. Right-click on the Repeat Maneuvers procedure and select Insert
Procedure After.

Select the Runway from Catalog option.
In the Filter field, type mugu and click Enter on your keyboard.
Select the POINT MUGU NAS (NAVAL BASE VEN 03 21) option.
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iv. Click Next.
V. Select Landing.
vi. Change the Approach Mode to Intercept Glideslope.
vii. Set the Runway Altitude Offset to seven (7) ft.
viii. Enable the Use Terrain for Runway Altitude option.
ix. Click Finish.
x. Click Apply.
0. Check Fuel State.

i. Right-click on the Landing procedure and select Profile Data at Final
State.

ii. Locate the Fuel Consumed and note the value.

iii. Close the Profile Data at Final State window.

=
)

p. Enable dynamic wind from NOAA ADDS Service (internet required ( & )).
i. Click the Mission Wind Model (&) button to enable wind.
ii. Change the Model type to NOAA ADDS Service.
iii. Click the Manage Data... change.
iv. Click the Add Current Forecast button.
V. Click OK to acceptand dismiss the ADDS Message Properties.
d. Enable dynamic wind from NOAA ADDS Service (No internet).
i. Click the Mission Wind Model (£¥) button to enable wind.
ii. Setthe Wind Speed to 50 nm/hr.
iii. Click OK.
r. Recheck the Fuel State.

i. Right-click on the Landing procedure and select Profile Data at Final
State.

ii. Locate the Fuel Consumed and note the value.
ii. Close the Profile Data at Final State window.
s. Add Crosswinds to the Mission Profile Window.
i. Right-click on the Mission Profile Window.
ii. Select Profile Options/Properties.

ii. Enable the Secondary Y Axis.
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iv. Select Course Crosswind.

v. Click OK.
t. Returnto the 3D Graphics window and Reset (l‘) the animation.
u. Zoom To the FA-18C_Hornet (ﬂ).
v. Play( ’ ) the animation and watch the flight.

E‘ Note: As you watch the nose of the aircraft, you will see crosswinds
affect the aircraft. This is called a crab angle.

0 Warning: Don't forget to save your work!
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Part 18: Assessing the Threat of a Collision

Required Product Licenses: This training requires additional licenses to complete. You can
obtain the necessary license for the training by visiting http://licensing.agi.com/stk/evaluation or
calling AGI support.

Space Situational Awareness and Conjunction Analysis Tool (CAT)

There are tens of thousands of space objects orbiting Earth every day, which makes for a pretty crowded highway
for your satellite. It is important to assess any potential collisions during launch, and while in orbit, to ensure the
safety of your mission assets. STK provides the tools to model and analyze the up-to-date locations of most of the
entire space catalog, allowing operators to analyze the likelihood of collisions in orbit.

Case Study

The used AGl's software to reduce radio frequency interference (RFI) geolocation
uncertainty by up to two orders of magnitude. You can read more in this case
study: SDA's Space Data Center Enables Fast, Accurate RFI Geolocation and
Conjunction Analysis.

The Advanced CAT tool provides a convenient way for you to carry out close approach analysis for multiple
satellites and two-line element (TLE) sets. After applying user-selected filters, Advanced CAT performs close
approach analyses between primary objects (e.g. satellites owned by or otherwise of interest to the user) and
secondary objects (those presenting a risk of collision), with reference to a threshold - a minimum acceptable
distance - between the ellipsoidal threat volumes of the objects.
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Task: Update the Satellite Database, Model a Satellite, and Identify Potential Threats

Itis important to ensure that you have the most up-to-date satellite data before performing
the analysis.

1. Create a new scenario with the default time period.

a. Click the Create a new scenario (ﬁ) button.

b. Inthe New Scenario Wizard, set the following options:
« Enter a name for the scenario (e.g. STK_CAT).
« Define the analysis stop time to be two days after the start time.

c. Click OK.
2. Use the Data Update Utility to update the satellite database.
a. Extend the Utilities menu and select Data Update...Data Update...
b. Select Update beside the satellite databasesatellite database Data set.
c. Click the Update Now button.
d. Click OK to dismiss the Data Update Utility.

3. Restart STK (E) to use the updated satellite database.
a. Save (@) your work.

b. Extend the File menu and select Open (ﬁ).
¢. Navigate to your scenario (e.g "STK_CAT") and open it.

4. Insertan active Earth observation satellite (%) from the Standard Object
Database (examples below).

=

=

a. Online( &)

[
i. Select Satellite in the Insert STK Objects (ﬂg) tool.

ii. Selectthe From Standard Object Database as the Select A Method
option.

iii. Click Insert.. to bring the Standard Object Database to the front.
iv. Selectthe Online tab.

V. Inthe Name or ID text field, enter a Satellite Name or ID (e.g.
Worldview) or select Earth Observation from the Mission drop-
down list and Operational from the Operational Status drop-down
list.

vi. Click Search. The matching satellites are shown in the Results field.
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Vii.

viii.
iX.

b. Local

Vi.

Vil.

vii.

iX.

Select the corresponding result (e.g. CommonName = Worldview-
2) from the list.

Click Insert.

Click Close to dismiss the Satellite Database window.

]
Select Satellite in the Insert STK Objects (ﬂg) tool.

. Select the From Standard Object Database as the Select A Method

option.

iii. Click Insert.. to bring the Standard Object Database to the front.

Select the Local tab.

In the Name or ID text field, enter a Satellite Name or ID (e.g.
Worldview) or select Earth Observation from the Mission drop-
down listand Operational from the Operational Status drop-down
list.

Click Search. The matching satellites are shown in the Results field.

Select the corresponding result (e.g. CommonName = Worldview-
2) from the list.

Click Insert.

Click Close to dismiss the Satellite Database window.

5. Right-click on the Satellite (%) in the Object Browser and select Zoom To.

6. Identify Potential Threats to your primary satellite (e.g. Worldview-2) from the
contents of the entire public catalog of tracked space objects.

7. Insertan AdvCAT (ﬁg) object using the Define Properties method.

Insert STK Objects tool. To do this, click the Edit Preferences
button and select it from the New Object tool.

[E/‘ Note: You may need to add the Advanced CAT object to the

]
b. Select AdvCAT (-.-EE) in the Insert STK Objects (ﬂg) tool. If you don't see the
AdvCAT object, click the Edit Preferences... button to add it to the Insert

STK Objects tool.

c. Select the Define Properties as the Select a Method option.

d. Click Insert... to bring the Properties Browser to the front.

8. Select the Primary Satellite list.
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a. Select the Primary satellite (e.g. Worldview-2) in the Available Primary list.

[
b. Click the Insert () button to add it to the Chosen list. You can add more
than one satellite or database to the Primary list.

9. Select the Secondary Satellite list.

a. Select the entire public catalog of tracked space objects (stkAIITLE.tce) in
the Available Secondary List.

[
b. Click the Insert () button to add it to the Chosen list. You can add more
than one satellite or database to the Secondary list.

10. Click the Compute button in the AdvCAT object's Properties to compute the

conjunctions.

11. View any conjunctions between your primary and secondary satellites.

a. Click Reset (l‘) on the animation toolbar to view the error ellipsoids in the
3D Graphics window.

b. Generate a Close Approach by Min Sep report using the Report & Graph
Manager.

Click the Report & Graph Manager () icon or extend the
Analysis menu and select Report & Graph Manager.

In the Object Type drop-down list, select AdvCAT.

iii. Selectthe AdvCAT object for the report that will be generated.

Expand (#) the Installed Styles directory and select Close
Approach by Min Sep.

Click Generate... to display the conjunctions sorted by minimum
separation.

¢. Visualize Conjunctions in the 3D Graphics Window.

Right-click on one of the Time In lines, click to open the Time
In menu, and select Set Animation Time.

Bring the 3D Graphics window to the front and click Step

Forward (lb) on the animation toolbar to see the ellipsoids
change color depending on their separation (e.g. red =

ellipsoid intersection; yellow = ellipsoids are within the
threshold; green = no conjunction).

AGI Techs Say: If you want to know when a new satellite is added to the
Satellite Database, subscribe to AGI's launch notification emails. These
notifications are sent as soon as a new satellite has been identified and
added to the database.
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4 )
AGI Techs Say: Primary objects are the satellites of interest to you. Primary
objects may include satellites that you own or want to use. Secondary objects
are those that present a potential risk of collision with, or approach closely,
to your primary objects.

Did You Know? By default, close approach computations use the distance
between the threat volumes or the user defined ellipsoids around the
primary and secondary satellites as the criterion. If Range is selected, the
close approach computation is performed using the range between the two
objects as the criterion rather than the ellipsoid separation.

0 Warning: Don't forget to save your work!
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Part 19: Design Tra’!ectories with Astrogator

Required Product Licenses: This training requires additional licenses to complete. You can
obtain the necessary license for the training by visiting http://licensing.agi.com/stk/evaluation or
calling AGI support.

Astrogator

STK Astrogator is a specialized analysis module for interactive orbit maneuver and spacecraft trajectory design. It
supports an unlimited series of events for modeling and targeting a spacecraft's trajectory, including impulsive
and finite burns and high-fidelty orbit propagation, while providing the ability to target specified and optimized
orbit states that reference customizable control and result parameters.

«Q Case Study

STK Astrogator was used to plan a series of maneuvers to get NASA's LADEE
spacecraft to the Moon. Learn more in the case study: AGI Software for NASA
Ladee Flight Dynamics System.

A Mission Control Sequence (MCS) - defines the trajectory as a sequence of events ("segments”), functioning as a
graphical programming language in which each segment dictates how Astrogator calculates the trajectory before
passing the spacecraft's state on the next segment. Some of the MCS segments available include:

o Initial State (") - This segment can be used to define the initial conditions of your MCS, or of a
subsequence within the MCS.

« Launch (,g) - This segment can be used to model a simple spacecraft launch from Earth or another central
body.

« Follow (#) - This segment can be used to set the spacecraft to follow another vehicle (Satellite, Launch
Vehicle, Missile, Aircraft, Ship, or Ground Vehicle) at a specified offset, and to separate from that vehicle
upon meeting specified conditions.

« Maneuver (|!) - This segment can be used to model a spacecraft maneuver.

« Propagate (&) - This segment can be used to model the movement of the spacecraftalong its current
trajectory until meeting specified stopping conditions

The Component Browser provides access to all available, customizable elements needed to construct a
trajectory with Astrogator. This includes MCS segments, propagators, stopping conditions, central bodies, engine
models, and more.
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Task: Model a Spacecraft Object Using STK Astrogator

1. Create a new scenario with a two (2) day analysis interval.

a. Click the Create a new scenario (&) button.

b. Inthe New Scenario Wizard, set the following options:
o Enter a name for the scenario (e.g. STK_Astrogator).
o Define the analysis start and stop times so the stop time is two (2)
days after the start time.

c. Click OK.
2. Inserta new satellite (ﬁ) with the Astrogator Propagator.

a. Inserta new satellite (ﬁ) using the Define Properties method.

b. Open the Properties (El) of the Satellite (ﬁ).

c. Select the Basic - Orbit page, and set the Propagator to Astrogator.
3. Setthe Satellite's Initial State in the MCS to Keplerian with a 0.015 Eccentricity.

a. Select the Initial State in the Mission Control Sequence (MCS).

b. Select Keplerian from the Coordinate Type drop-down list.

c. Enter 0.015 in the Eccentricity text field.

4. Create a new Periapsis stopping condition for the existing propagate (@')
segment and remove the duration stopping conditions.

a. Create a new Periapsis stopping condition.

i. Selectthe existing propagate (@') segment in the MCS.

ii. Clickthe New...icon (D) in the Stopping Conditions section on the
right or right-click on the existing Duration stopping condition and

select New... (D).

iii. Select Periapsis in the New stopping condition window and click
OK.

b. Remove the Duration stopping condition.

i. Select the Duration stopping condition in the Stopping Conditions
section on the right.

ii. Click the Delete icon (X) or right-click on the Duration stopping
condition and select Delete (#%).

c. Right-click on the propagate segment in the MCS, select Rename, and
rename it PropToPeriapsis.
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AGI Techs Say: You can set multiple stopping conditions for a
propagate segment. Astrogator stops propagating the satellite when
it meets one of the stopping conditions.

5. Click Run Entire Mission Control Sequence () on the MCS toolbar to run the
MCS.

6. Inserta new maneuver segment( #) after the first propagate segment (@') with
a Delta V Magnitude value of 1,000 m/sec along the Velocity Vector.

a. Click on the first propagate segment to highlight it and click Insert Segment

(D) on the MCS toolbar or right-click on the first propagate segment and
select Insert After... from the menu.

b. Select Maneuver in the Segment Selection window and click OK.
c. Setthe Delta V Magnitude to 1,000 m/sec.
d. Keep the default for the Attitude Control as Along Velocity Vector

option.

AGI Techs Say: There are two different types of Maneuvers available,
impulsive and finite. The Impulsive maneuver calculates a state by
adding the defined delta-v vector to the velocity of the final state of
the previous segment. The finite maneuver is basically a propagate
segment with thrust.

7. Inserta new apoapsis propagate segment (@') named PropToApoapsis after the

maneuver segment (% ).

a. Inserta new Propagate segment in the MCS.

i. Click on the Maneuver segment to highlight it and click Insert

Segment (D) on the MCS toolbar or right-click on the Maneuver
segment and select Insert After... from the menu.

ii. Select Propagate in the Segment Selection window and click OK.

b. Create a new Apoapsis stopping condition.

i. Selectthe new Propagate (@) segment in the MCS.

ii. Click the New icon (D) in the Stopping Conditions section or right-
click the existing Duration stopping condition and select New...

iii. Select Apoapsis in the New stopping condition window and click
OK.

C. Remove the Duration Stopping Condition.
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i. Select the Duration stopping condition in the Stopping Conditions
section on the right.

ii. Click the Delete icon (X) or right-click on the Duration stopping
condition and select Delete (X).

d. Right-click on the propagate segment in the MCS, select Rename, and
rename it PropToApoapsis.

e. Give each segmenta unique color.

i. Double-click the segment in the MCS or right-click the segment and
select Properties...

ii. Selectthe desired color in the Color drop-down menu from the Edit
Segment window.

iii. Click OK to dismiss the Edit Segment window.

8. Click Run Entire Mission Control Sequence () on the MCS toolbar to run the
MCS.

Target Sequences

Target Sequence (gl) are used to calculate and subsequently define the required maneuver characteristics
necessary to meet specified or optimal mission parameters. Once a target sequence is inserted into the MCS, itis

defined in three steps:

« Insertthe segments that define the controls or results of the targeting calculation inside the target
sequence.

« Select the target sequence and define one or more profiles. These target profiles set the type of search
algorithm that is used or could alter the properties of the targeted segments to affect the course of the
MCS run without halting the trajectory creation.

« Configure the target sequence by accessing the properties of each profile.

Atarget sequence runs the segments nested within it and applies profiles to the run according to its configuration.
When applying a search profile such as a Differential Corrector, the target sequence adjusts the targeted values
over multiple iterations in an attempt to converge at a solution within the defined tolerance. The results of a target
sequence are applied to the MCS to produce a trajectory that meets the goals you need to achieve.
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Task: Use a Target Sequence to Raise Your Orbit

1. Add a target sequence (gl) named RaiseOrbit after the PropToApoapsis
segment (&=").

a. Click on the PropToApoapsis segment to select it.

b. Click Insert Segment (D) on the MCS toolbar or right-click
PropToApoapsis and select Insert After... from the menu.

c. Select Target Sequence in the Segment Selection window and click OK.

2. Add the maneuver and PropToApoapsis segments to the new target sequence.

a. Drag and drop the Maneuver (#) segment into the Target Sequence to
nest it.

b. Drag and drop the PropToApoapsis segment into the Target Sequence

after the Maneuver to nest it.

3. Select the maneuver's Delta V Magnitude as a Control Parameter (g').

a. Click on the Maneuver segment within the Target Sequence in the MCS.

b. Click the Targeticon (gl) to the right of the Delta V Magnitude to make it
the independent variable. The selection is confirmed by the appearance of

a check mark over the icon (@).

4. Add the Altitude of Apoapsis as a new Result for the PropToApoapsis segment.

a. Click on the PropToApoapsis segment within the Target Sequence in the
MCS.

b. Click Results... below the MCS to bring up the User-Selected Results
window.

c. Expand (#) Keplerian Elems and select Altitude of Apoapsis.

d. ClickInsert Component (ME#) to select it as the dependent variable.

e. Click OK to close the User-Selected Results window.
5. Configure the Target Sequence.

a. Access the Differential Corrector profile's properties for the Target
Sequence.

i. Selectthe Target Sequence, RaiseOrbit, in the MCS.

ii. Inthe Profiles section on the right, click the Properties icon (El) to
open the Variables page or right-clicking the Differential Corrector

and select Properties... from the menu.

b. Setup the Targeter.
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i. Selectthe Use option in the Control Parameters and Equality
Constraints (Results) sections.

ii. Setthe Desired Value for the Altitude of Apoapsis to 7500 km.
iii. Click OK to dismiss the Differential Corrector Properties window.

iv. Change the Action to Run Active Profiles in the drop-down list.

. Click Run Entire Mission Control Sequence () on the MCS toolbar to run the
MCS.

gf Note: Once you have applied the changes you can set the Action to
Run Nominal Sequence. This runs the mission control sequence using
the results of the Targeter.

. Click Apply Changes in the Profiles and Corrections section of the parameters
to apply the current values.

. Click Run Entire Mission Control Sequence () on the MCS toolbar to run the
MCS to look at the final trajectory design.
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Task: Use a Target Sequence to Raise the Altitude at Periapsis

1. Add a target sequence (gl) named RaiseAltitude after the RaiseOrbit target
sequence (gl).

a.

Click on the RaiseOrbit segment to highlight it and click Insert Segment (D)
on the MCS toolbar or right-click on RaiseOrbit segment and select Insert
After... from the menu.

Select Target Sequence in the Segment Selection window and click OK.

Right-click on the new Target Sequence in the MCS, select Rename, and
rename it RaiseAltitude.

2. Inserta new maneuver segment (ﬁ) within the RaiseAltitude target sequence (

9,

a.

Click on the target sequence's Return Segment (4") to selectitand click

Insert Segment (D) or right-click on the target sequence's return segment
and select Insert After... from the menu.

Select Maneuver in the Segment Selection window and click OK. Keep the
default Delta V Magnitude and Attitude Control.

3. Select the maneuver's Delta V Magnitude as a Control Parameter.

a.

Click on the Maneuver segment within the Target sequence in the MCS.

Click the Targeticon (gl) to the right of the Delta V Magnitude to make it
the independent variable. The selection is confirmed by the appearance of

a check mark over the icon (g').

4. Inserta new periapsis propagate segment (@') named PropToPeriapsis after the

target segment's maneuver segment (2% ).

a.

b.

Insert a new Propagate Segment in the RaiseAltitude target sequence.

i. Click on the Maneuver segment to highlight it and click Insert

Segment (D) on the MCS toolbar or right-click on the Maneuver
segment and select Insert After... from the menu.

ii. Select Propagate in the Segment Selection window and click OK.

Create a new Periapsis stopping condition.

i. Selectthe new Propagate (@) segment in the MCS.

ii. Clickonthe Newicon (D) in the Stopping Conditions section or
right-click on the existing Duration stopping condition and select
New...
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iii. Select Periapsis in the New Stopping Condition window and click
OK.

C. Remove the Duration stopping condition.

i. Selectthe Duration stopping condition in the Stopping Condition
section on the right.

ii. Click the Delete Segmenticon (X) or right-click on the Duration
stopping condition and select Delete.

d. Right-click on the new propagate segment in the MCS, select Rename, and
rename it PropToPeriapsis.

5. Add the Altitude of Periapsis as a new Result for the PropToPeriapsis segment.

a. Click onthe PropToPeriapsis segment within the Target Sequence in the
MCS.

b. Click Results... below the MCS to bring up the User-Selected Results
window.

c. Expand (#) Keplerian Elems and select Altitude of Periapsis.

d. ClickInsert Component (ME#) to select it as the dependent variable.
e. Click OK to close the User-Selected Results window.
6. Give each segment a unique color.

a. Double-click the segmentin the MCS or right-click the segment and select
Properties...

b. Selectthe desired color in the Color drop-down menu from the Edit
Segment window.

. Click OK to dismiss the Edit Segment window.
7. Configure the Target Sequence.

a. Access the Differential Corrector profile's properties for the Target
Sequence.

i. Select the Target Sequence, RaiseAltitude, in the MCS.

ii. Selectthe Default Profile (Differential Corrector).

iii. Inthe Profiles section on the right, click the Properties icon (El) to
open the Variables page or right-click the Differential Corrector and

select Properties... from the menu.
b. Setup the Targeter.

i. Selectthe Use option in the Control Parameters and Equality
Constraints (Results) option.
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ii. Setthe Desired Value for the Altitude of Periapsis to 3000 km.
iii. Click OK to dismiss the Differential Corrector Properties window.

iv. Change the Action to Run Active Profiles in the drop-down list.

8. Click Run Entire Mission Control Sequence () on the MCS toolbar to run the
MCS.

AGI Techs Say: By default, the 3D Graphics window displays the
iterations of a search profile during an MCS run before it converges
on a final solution.

9. Click Apply Changes in the Profiles and Corrections section of the parameters
to apply the current values.

E‘ Note: Once you have applied the changes you can set the Action to
Run Nominal Sequence. This runs the mission control sequence using
the results of the Targeter.

10. Click Run Entire Mission Control Sequence () on the MCS toolbar to run the
MCS to look at the final trajectory design.

11. Add a final propagate segment at the end of the MCS that ends after a half day.
a. Inserta new Propagate segment in the MCS.

i. Click on the RaiseAltitude target sequence in the MCS and click

Insert Segment (D)on the MCS toolbaror right-click on the
RaiseAltitude target sequence and select Insert After... from the
menu.

ii. Select Propagate in the Segment Selection window and click OK.
The default Duration stopping condition is a half day (43200 sec).

b. Click Run Entire Mission Control Sequence () on the MCS toolbar to
run the MCS.

12. Generate a Maneuver Summary report of the mission.

a. Right-click on the Satellite (ﬁ) in the Object Browser.

b. Selectthe Report & Graph Manager ).

C. Expand () the Installed Styles directory and select the Maneuver Summary
report.

d. Click Generate...

AGI Techs Say: View the Astrogator's Guild (http://www.astrogatorsguild.com) for additional
tutorials, scenarios, blogs, and white papers.
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0 Warning: Don't forget to save your work!
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Become Level 2: STK Master Certified

Now that you have completed Comprehensive training, you are well-prepared to complete the STK Level 2
Certification test. The STK Master Certification is the second level of certification and validates your ability to
perform more advanced STK modeling and analysis through use of add-on modules (Pro, Coverage,
Communications, Integration, Aviator).

What's in the Test?

The Level 2 - STK Master Certification test consists of four scenario development exercises and one bonus
exercise. There are multiple choice questions for each exercise. You have 14 days from registration date to
complete Master Certification. The following objectives are tested:

« Model Your Systems - Advanced Aircraft (Aviator), Advanced Satellite (Astrogator), Missile, Sensor,
Constellation, Chain, Advanced Constraints, Terrain, Communications, Radar, RF Environment models, STK

External Propagator, Vehicle Attitude
o Analyze Your Systems - Access Tool, Report & Graph Manager, Custom Reports, Coverage, Figure of Merit,

Analysis Workbench (Vector Geometry Tool)
o Extend STK - Connect commands to model objects, enable constraints, and generate reports

E‘ Note: MATLAB and Analyzer are not tested on the certification. You don't require a license for
those two products.

Once you earn your STK Master Certification, you will receive an STK Master Certification and an insulated thermos!
Register now on our on our website (http://www.agi.com/training/certification).
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